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In this section: 

Who Should Read This Guide ........................................................................... 6 
Typographical Conventions ............................................................................... 6 
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Who Should Read This Guide 

This guide is intended for single domain owners, who were provided with access to Plesk 
control panel as part of their shared or dedicated hosting package. 

Typographical Conventions 

Before you start using this guide, it is important to understand the documentation 
conventions used in it.  

The following kinds of formatting in the text identify special information. 

Formatting 
convention 

Type of Information Example 

Special Bold Items you must select, such as 
menu options, command 
buttons, or items in a list. 

Go to the System tab. 

 Titles of chapters, sections, and 
subsections. 

Read the Basic 
Administration chapter. 

Italics Used to emphasize the 
importance of a point, to 
introduce a term or to 
designate a command line 
placeholder, which is to be 
replaced with a real name or 
value. 

The system supports the 
so called wildcard 
character search. 

Monospace  The names of commands, files, 
and directories. 

The license file is located 
in the 
http://docs/common

/licenses  directory. 

Preface 

http://docs/common/licenses
http://docs/common/licenses


 

 Preface 7 

 

Preformatte

d 
On-screen computer output in 
your command-line sessions; 
source code in XML, C++, or 
other programming languages. 

# ls ïal /files  

total 14470  

Preformatte

d Bold  
What you type, contrasted with 
on-screen computer output. 

# cd 

/root/rpms/php  

CAPITALS Names of keys on the 
keyboard. 

SHIFT, CTRL, ALT 

KEY+KEY Key combinations for which the 
user must press and hold down 
one key and then press 
another. 

CTRL+P, ALT+F4 

 
 

Feedback 

If you have found a mistake in this guide, or if you have suggestions or ideas on how to 
improve this guide, please send your feedback to userdocs@swsoft.com. Please include in 
your report the guide's title, chapter and section titles, and the fragment of text in which you 
have found an error. 

mailto:userdocs@swsoft.com
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Logging In to Plesk 

ü To log in to your Plesk control panel: 

1 Open your web browser, and in the address bar type the URL where 
your Plesk control panel is located (for example, 
https://your.domain.com:8443). 

2 Press ENTER.  

Plesk login screen will open. 

3 Type the login name and password your provider gave you into the 
Login and Password boxes, respectively.  

Your login name would be your domain name. 

4 If you log in for the first time, select the language for your control 
panel from the Interface language drop-down box.  

If you had previously specified the interface language and saved it in your interface 
preferences, leave the User default value selected. 

5 Click Login. 
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https://your.domain.com:8443/
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Becoming Familiar with Plesk's Interface 

When you log in to control panel, it can open in either a standard view, a simplified 
desktop view, or a combination of both. The standard view is a customary view of the 
control panel divided into two main areas: navigation pane on the left and the main 
screen where operations are performed on the right. 

 

Figure 1: Standard view of the control panel. 

The desktop view can show site statistics and shortcuts to the operations you 
frequently performðeverything you may need can now be accessible from a single 
screen. 
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Figure 2: Desktop view of the control panel. 

If your hosting plan includes the Web site creation and management service using 
Sitebuilder, the following shortcuts are also shown in your control panel's navigation 
pane: 

Á Desktop. This provides shortcuts to the task-oriented wizards. Here you can perform 
any operations on your account and Web site through the Sitebuilder system. For 
more information, see 
http://download1.swsoft.com/SiteBuilder/4.0.0/doc/site_owner/en_US/html/using_de
sktop_interface.htm. 

Á Sites. Here you can add and manage sites. For more information, see 
http://download1.swsoft.com/SiteBuilder/4.0.0/doc/site_owner/en_US/html/managin
g_sites.htm. 

Also, on your Home page, the Sitebuilder Wizard button is shown. You should use it for 
accessing the Sitebuilder Web site creation and management wizard. For more 
information, refer to the section Creating and Publishing Web Sites Using Sitebuilder 
(on page 27).  

In this section: 

Items in the Standard View ................................................................................ 11 
Items in the Desktop View ................................................................................. 11 
 
 

http://download1.swsoft.com/SiteBuilder/4.0.0/doc/site_owner/en_US/html/using_desktop_interface.htm
http://download1.swsoft.com/SiteBuilder/4.0.0/doc/site_owner/en_US/html/using_desktop_interface.htm
http://download1.swsoft.com/SiteBuilder/4.0.0/doc/site_owner/en_US/html/managing_sites.htm
http://download1.swsoft.com/SiteBuilder/4.0.0/doc/site_owner/en_US/html/managing_sites.htm
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Items in the Standard View 

The navigation pane is located on the left. It gives you access to sets of administrative 
functions: 

Á Home. Web site and e-mail administration tools. You will spend most of the time in 
this area. 

Á Sessions. Management of your mail usersô sessions in the control panel and FTP 
connections to your host. For more information on managing sessions, refer to 
chapter Monitoring Connections to Control Panel and FTP Services (on page 101). 

Á Log Out. When finished working with control panel, click this icon to end your 
session. 

Á Help Desk. Use it to report your problems to server administrator or providerôs 
technical support. For more information on this feature, refer to chapter Using Help 
Desk for Requesting Assistance From Service Provider (on page 104). 

Á Help. Provides context sensitive help. 

Below the Help icon, there is a context help tip area. It provides a brief description of the 
current screen or available operations. When you place the mouse pointer over a 
system element or status icon, it displays additional information. 

To navigate through Plesk, you can also use a path bar: a chain of links that appears in 
the right part of the screen, below the banner area. To return to a previous screen, click 

 Up Level in the upper-right corner of the screen. 

To find items in lengthy lists, use search boxes located above every list of items: type a 
search criterion into the input box, and click Search. A list will show the items matching 
the search criteria. To return back to viewing all items, click Show All. You can hide the 
search area by clicking Hide Search. To show the hidden search area, click Show Search. 

To sort a list by a certain parameter in ascending or descending order, click on the 
parameter's title in the column heading. The order of sorting will be indicated by a small 
triangle displayed next to the parameter's title. 

To customize your control panel in the Standard view, refer to the Customizing Your 
Control Panel in the Standard View (on page 17) section. 

Items in the Desktop View 

The desktop view originally shows three sections: 

Á Tools. This group shows shortcuts to the operations that you can perform through 
the control panel. You can freely add and remove these shortcuts. 

Á Statistics. This shows the number of e-mail accounts you have under your domain, 
disk space and montly bandwidth usage, and number of served subdomains (parts 
of your main site or separate sites under your parent domain). 
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Á Favorites. This group shows three types of shortcuts sorted by type and placed on 
the respective tabs. The Mailnames tab shows shortcuts to the favorite e-mail 
accounts. The Shortcuts tab shows all other types of shortcuts that do not relate to 
e-mail user accounts. The Recent tab shows last ten control panel screens you have 
been on. The Favorites group also provides search tool for finding e-mail accounts. 
To use the search tool, type the search criteria (this can be any combination of 

symbols, search is case insensitive) and click  Search.    

To customize your control panel in the Desktop view, refer to the Customizing Your 
Control Panel in the Desktop View (on page 19) section. 

In this section: 

Using Wizards ................................................................................................... 13 
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Using Wizards 

When you work with Plesk in the Desktop view, you accomplish the tasks you need 
through wizards. Each wizard is a series of consecutive screens. To accomplish a task 
using a wizard, follow the instructions displayed on the wizard screens. For information 
on individual options, refer to the respective sections of this guide. 

Changing Your Contact Information and 
Password 

ü If you need to update your contact information, or change password: 

1 Click Domain Administrator in the Domain group. 

2 Update your information as required, or type a new password, and 
click OK.  

 

ü If you forgot your password: 

1 In your web browserôs address bar, type the URL where your Plesk 
control panel is located. For example, https://your.domain.com:8443. 

2 Press ENTER.  

Plesk login screen will open. 

3 Click the Forgot your password? link. 

4 Type your domain name into the Login box, and type your e-mail 
address registered in the system into the E-mail box.  

5 Click OK.  

Your password will be sent to your e-mail address. 

 

 

https://your.domain.com:8443/


 

  
 

In this chapter: 

Setting Up Global Account ................................................................................ 14 
Customizing Your Control Panel in the Standard View ...................................... 17 
Customizing Your Control Panel in the Desktop View ....................................... 19 
 
 

Setting Up Global Account 

Global Account is a Single Sign-On technology feature that allows you to log in to 
different SWsoft products using a single global login and password. If you have several 
accounts in Plesk, you can connect them all to a global account and switch between 
these accounts without entering a password every time. You can also connect all your 
accounts in other SWsoft products to your global account and switch between them 
without providing credentials. 

After you create a global account and connect local accounts to it, you will be able to 
choose from any account connected to your global account when logging in under your 
global account. 

Note. Single Sign-On technology and the ability to use global accounts can only be 
activated through API or Command Line Utility means. Please refer to your Service 
Provider or the respective documentation for more information on activating Single 
Sign-On. 

In this section: 

Creating A Global Account ................................................................................ 15 
Connecting Local Accounts To Your Global Account ......................................... 15 
Switching Between Accounts ............................................................................ 16 
Changing Global Account Password ................................................................. 16 
Disconnecting Local Accounts From Global Account ......................................... 17 
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Creating A Global Account 

ü To create a global account: 

1 Log in to Plesk, go to Global Account and click Connect To Global Account. 

2 Select Create new global account and provide the login and password for 
your global account. 

3 Click OK. 

Your global account is active now, so you can proceed with connecting other accounts 
to it. Refer to Connecting Local Accounts to Your Global Account (on page 15) section 
for more information. 

Connecting Local Accounts To Your Global Account 

ü To connect a local Plesk account to your global account: 

1 Log in to Plesk under the local account you want to connect. 

2 Go to Global Account and click Connect To Global Account. 

3 Make sure that Use existing global account option is selected and provide 
the login and password for the global account you want to connect to.  

4 Click OK. 

Repeat steps 1-4 for other local accounts as necessary. 

ü To connect an account in another product with SSO support to your global account: 

1 Log in to software product with SSO support under the account you 
want to connect. 

2 Follow the instructions on connecting to a global account in respective 
software product documentation. Make sure that you provide the 
credentials for the existing global account when you are asked to.  

Repeat steps 1-2 for other accounts or products as necessary. 

Note. Different software products may use different names for the Global Account 
feature, such as Federated Identity or Global Login. Refer to respective software 
product documentation for more information. 

After you have connected all required accounts to your global account, you can log in 
under your global account all the time in any product where you have a local account 
connected to your global account. You will be shown the list of local accounts 
connected to your global account every time you log in under it, so you can choose 
which account you would like to use now. You can switch to another account any time 
you want. Refer to Switching Between Accounts (on page 16) section for more 
information. 
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Switching Between Accounts 

ü To switch to another account: 

1 Click Switch User in the upper right corner. 

2 Select the account you want to switch to:  

Á Choose the required local account from the list of accounts connected to your 
global account 

or 

Á Select Specify credentials for another account and provide login and password for a 
local account not connected to your global account or to another global account. 
You can also specify the language for your control panel from the Interface 
language menu. If you had previously specified the interface language for that 
account and saved it in its interface preferences, leave the Default value 
selected. 

3 Click OK. 
 

Changing Global Account Password 

ü To change password of your global account: 

1 Log in to Plesk under your global account or any local account 
connected to it. 

2 Go to Global Account and click Change Password. 

3 Enter your old and new passwords, and click OK. 
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Disconnecting Local Accounts From Global Account 

ü To disconnect a local account from your global account: 

1 Log in to Plesk under the local account you want to disconnect.  

2 Go to Global Account and click Disconnect From Global Account. 

3 Confirm the disconnection and click OK. 

Repeat steps 1-3 for other local accounts as necessary. 

Customizing Your Control Panel in the 
Standard View 

In this section: 

Setting Interface Language and Skin for Your Control Panel ............................. 17 
Adding a Hyperlink Button to Your Control Panel .............................................. 18 
Removing a Hyperlink Button from Your Control Panel ..................................... 18 

 
 

Setting Interface Language and Skin for Your Control 
Panel 

ü To select an interface language and theme (skin) for your control panel: 

1 On your Home page, click Domain Administrator in the Domain group. 

2 In the Preferences group, select the desired interface language and skin 
from the respective drop-down boxes.  

Pleskôs interface has been translated to a number of different languages, so if you 
do not see your own language in the list, ask your provider to install the respective 
language pack. You can also change your contact information here. For instructions 
on how to change your contact information, refer to the Changing Your Contact 
Information (on page 13) section. 

3 Click OK. 
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Adding a Hyperlink Button to Your Control Panel 

ü To add a custom hyperlink button to your Plesk control panel: 

1 On your Home page go to Custom Buttons and click Add New Button. 

2 Specify properties of the button: 

Á Type the text that will show on your button in the Button label field. 

Á Choose the location for your button. To place it in the right frame of your Home 
page, select the Domain Administration page value as the location. To place it in 
the left frame (navigation pane) of your control panel, select the Navigation pane 
value. 

Á Specify the priority of the button. Plesk will arrange your custom buttons on the 
control panel in accordance with the priority you define: the lower the number ï 
the higher is priority. Buttons are placed in the left-to-right order. 

Á To use an image for a button background, type the path to its location or click 
Browse to browse for the desired file. It is recommended that you use a 16x16 
pixels GIF or JPEG image for a button to be placed in the navigation pane, and 
32x32 pixels GIF or JPEG image for buttons placed in the main frame. 

Á Type the hyperlink of your choice to be attached to the button into the URL field. 

Á Using the checkboxes, specify whether to include the data, such as domain id 
and domain name to be transferred within the URL. These data can be used for 
processing by external web applications. 

Á In the Context help tip contents input field, type in the help tip that will be displayed 
when you hover the mouse pointer over the button. 

Á Select the Open URL in the Control Panel checkbox if you wish the destination URL 
to be opened in the control panel's right frame, otherwise leave this checkbox 
unchecked to open the URL in a separate browser window. 

Á If you wish to make this button visible to the mailbox users with access to control 
panel, select the Visible to all sub-logins checkbox. 

3 Click OK to complete creation. 

 
 

Removing a Hyperlink Button from Your Control Panel 

ü To remove a hyperlink button from your Plesk control panel: 

1 Click Custom Buttons in the Tools group. 

2 Select a check box corresponding to the button that you wish to 
remove.  

3 Click  Remove Selected. Confirm the removal and click OK. 
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Customizing Your Control Panel in the 
Desktop View 

ü To add or remove items from the desktop: 

1 Go to Desktop >  Customize Desktop. 

2 In the Tools group, specify what tasks you would like to accomplish 
through the control panel. The appropriate shortcuts will be placed to 
the desktop. The Selected tasks list shows the tasks for which shortcuts 
are already placed on the desktop. The Available tasks list shows the 

tasks for which you do not yet have shortcuts on your desktop.  

Á To add a shortcut to the desktop, select the required tasks in the Available tasks 
list and click Add >>. 

Á To remove a shortcut from the desktop, select the task that you do not need in 
the Selected tasks list and click << Remove. 

3 To show your custom buttons on the desktop, select the Custom buttons 
check box. 

4 To show the shortcut for creating new custom hyperlink buttons at the 
bottom of the desktop, select the Create a new domain custom button check 
box. 

5 Specify whether to show the Statistics and Favorites groups and what 
items to show there. Clearing check boxes will remove the respective 
items from the desktop. The Favorites group shows the links to items or 
control panel screens that you added to desktop by navigating to the 

respective control panel screens and clicking  Create shortcut or  Add 
to favorites. 

6 Click OK. 

 

ü To add a mail account to the Favorites group of the desktop: 

1 Go to Mail > e-mail address and click  Add to favorites in the upper right 
corner of the screen. 

2 Specify the desktop shortcut label and the description.  

3 Click OK. 

 

ü To add items to the Favorites group of the desktop: 

1 Navigate to the control panel screen you need. 

2 Click  Create Shortcut in the upper right corner of the screen. 

3 Specify the desktop shortcut label and the description.  

4 Click OK. 
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ü To remove items from the Favorites group of the desktop: 

1 On the desktop, click the shortcut that you wish to remove.  

2 Click  Edit Favorites in the upper right corner of the screen. 

3 Click Remove. 

OR 

1 On the desktop, click the  icon corresponding to the shortcut that 
you wish to remove. 

2 Click Remove. 

 

 



 

  
 

To review or select the hosting features available for your account (if your provider 
delegated the permission to manage the hosting options for your account): 

1 Click the Setup on your Home page. 

2 View or change your hosting options:  

Á IP Address. Your domain can be hosted on either exclusive IP address or shared 
IP address. Choose an address from your service provider's IP addresses pool. 

Á Certificate. Shows the SSL certificate used by your site. 

Á SSL support. Secure Sockets Layer encryption is generally used for protecting 
transfer of sensitive data during online transactions on e-commerce Web sites 
that run on dedicated IP addresses. SSL certificates that participate in the 
encryption process are usually applied to a single domain name on a single IP 
address, therefore, each site that needs SSL protection must be hosted on a 
dedicated IP address. An exception to this is subdomains, which you can 
protect with a wildcard certificate. Installing an SSL certificate on a Web server 
that hosts several web sites with different domain names on a single IP address 
(shared or name-based hosting) is technically possible, however, it is not 
recommended: the encryption will be provided, but users will get warning 
messages on attempt to connect to the secure site. To allow SSL encryption for 
Web sites, select the SSL support check box. 

Á Use a single directory for housing SSL and non-SSL content. By default, when users 
publish their sites through their FTP accounts, they need to upload the web 

content that should be accessible via secure connections to the httpsdocs  

directory, and the content that should be accessible via plain HTTP, to the 

httpdocs  directory. For the convenience of  publishing all content through a 

single location ï httpdocs  directory, select the Use a single directory for housing 

SSL and non-SSL content check box. 

Á FTP login and FTP password. Specify the user name and password that will be 
used for publishing the site to the server through FTP. Retype the password into 
the Confirm Password box. 

Á Hard disk quota. Specify the amount of disk space in megabytes allocated to the 
web space for this site. This is the so-called hard quota that will not allow writing 
more files to the web space when the limit is reached. At attempt to write files, 
users will get the "Out of disk space" error. Hard quotas should be enabled in 
the server's operating system, so if you see the "Hard disk quota is not 
supported" notice to the right of the Hard disk quota field, but would like to use the 
hard quotas, contact your provider or the server administrator and ask to enable 
the hard quotas. 

Á Shell access to server with FTP user's credentials. This allows you to upload securely 
web content to the server through a Secure Socket Shell connection, however, 
allowing shell access also poses a potential threat to the server security, so we 
recommend that you do not allow shell access. Leave the Forbidden option 
selected. 

C H A P T E R  3  

Reviewing Your Hosting Package 
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Á FrontPage support. Microsoft FrontPage is a popular web site authoring tool. To 
enable users to publish and modify their sites through Microsoft FrontPage, 
select the FrontPage support and FrontPage over SSL support check boxes, set the 
FrontPage authoring option to allowed, and specify the FrontPage Administrator's login 
and password. 

Á Support for programming and scripting languages supported by your hosting 
environment. Specify which of the following  programming and scripting 
languages should be interpreted, executed or otherwise processed by the web 
server: Active Server Pages (ASP), Server Side Includes (SSI), PHP hypertext 
preprocessor (PHP), Common Gateway Interface (CGI), Fast Common 
Gateway Interface (FastCGI), Perl, Python, ColdFusion and Miva scripting 
required for running Miva e-commerce solutions. 

Á Web statistics. To allow you to view the information on the number of people 
visited your site and the pages of the site they viewed, select the required 
program from Web statistics menu (AWStats is recommended) and select the 
accessible via password protected directory /plesk-stat/ check box. This will install the 
statistics program, which will generate reports and place them into the password 
protected directory. You will then be able to access Web statistics at the URL: 
https://your-domain.com/plesk-stat/webstat using your FTP account login and 
password. 

Note: When you switch from one statistics program to another, all reports 
created by the previously used statistics program are deleted and new 
reports are created in accordance with the information read from log files 
kept on the server. This means that if you configured the system (at Log 
Manager > Log Rotation) so as to keep log files only for the last month, then 
Web statistics will be available only for the last month.    

Á Custom error documents. When visitors coming to your site request pages that the 
web server cannot find, the web server generates and displays a standard 
HTML page with an error message. If you wish to create your own error pages 
and use them on your web server, select the Custom error documents check box. 

3 Click OK. 

  

In this chapter: 

Viewing the Permissions for Operations You Can Perform through the Control Panel
 .......................................................................................................................... 24 
 

 

To view the amounts of resources your Web site and e-mail accounts can consume: 

1 Click the Limits icon on your Home page. 

2 The resource allotments are listed as follows: 

Á Maximum number of subdomains. The number of subdomains that can be hosted 
under your domain. 

Á Maximum number of domain aliases. The number of additional alternative domain 
names that you can use for your site. 

https://your-domain.com/plesk-stat/webstat
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Á Disk space. The total amount of disk space allocated to your hosting account. 
This amount is measured in megabytes. It includes disk space occupied by all 
files related to this domain/web site: web site contents, databases, applications, 
mailboxes, log files and backup files. This is the so-called soft quota: when it is 
exceeded, domain names and web sites are not suspended automatically, only 
the appropriate notices are sent to your provider's e-mail addresses and the 

resource overage is indicated by a corresponding icon  shown in the control 
panel to the left of your domain name. When your web site starts growing and 
requires more disk space, consider upgrading your hosting plan. 

Á Maximum amount of traffic. Displays the amount of data in megabytes that can be 
transferred from your web site during a month. Once the limit is reached, the 
appropriate notices are sent to your provider's e-mail addresses and the 

resource overage is indicated by a corresponding icon  shown in the control 
panel to the left of the domain name. When your web site starts attracting more 
visitors and requires more bandwidth, consider upgrading your hosting plan. 

Á Maximum number of web users. Shows the number of personal web pages that you 
can host for other users under your domain. This service is mostly used in 
educational institutions that host non-commercial personal pages of their 
students and staff. These pages usually have web addresses like http://your-
domain.com/~username. If the Allow the web users scripting check box is selected, 
execution of scripts embedded in personal web pages is allowed. See the 
Hosting Personal Web Pages on Your Web Server section for details. 

Á Maximum number of databases. Displays the number of databases that can be 
hosted in your domain. 

Á Maximum number of mailboxes. Shows the number of mailboxes that can be hosted 
in your domain. 

Á Mailbox quota. Displays the amount of disk space in kilobytes that is allocated for 
storing e-mail messages and autoresponder attachment files to each mailbox in 
your domain.  

Á Maximum number of mail forwarders. Shows the number of mail forwarders that can 
be used in your domain. 

Á Maximum number of mail autoresponders. Displays the number of automatic 
responses that can be set up in your domain. 

Á Maximum number of mailing lists. Shows the number of mailing lists that you can 
run in a domain. The mailing lists are served by the GNU Mailman software, 
which may or may not be installed on the server. If it is not installed and you 
would like to use it, ask your service provider to install it.  

Á Maximum number of Java applications. Displays the maximum number of Java 
applications or applets that you can install in a domain. 

Á Validity period. Shows the term for a hosting account. At the end of the term, your 
domain/web site will be suspended, its Web, FTP and mail services will no 
longer be accessible to the Internet users, and you will not be able to log in to 
the control panel.  

3 Click OK. 

  
 

http://your-domain.com/~username
http://your-domain.com/~username
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Viewing the Permissions for Operations 
You Can Perform through the Control 
Panel 

To view the permissions for operations you can perform through your control panel: 

1 Click the Domain Administrator icon on your Home page. 

2 The permissions are listed in the Permissions group: 

Á Physical hosting management. Shows whether you can fully control hosting 
account for your web site. If it says No, then you can only change FTP password 
for accessing your web space. 

Á FTP password management. Shows whether you are allowed to change your 
credentials for access to web space through FTP. 

Á Management of shell access to the server. Shows whether you can access the server 
shell. 

Á Hard disk quota assignment. Shows whether you can set up the hard quota on disk 
space allocated to your site. 

Á Subdomains management. Shows whether you can set up, modify and remove 
subdomains in your domain. 

Á Domain aliases management. Shows whether you can set up additional alternative 
domain names for your web site. 

Á Log rotation management. Shows whether you can adjust the cleanup and 
recycling of processed log files for your site. 

Á Anonymous FTP management. Shows whether you can have an FTP directory 
where all users could download and upload files without the need to enter login 
and  password. A web site should reside on a dedicated IP address in order to 
use anonymous FTP service. 

Á Task scheduling. Shows whether you can schedule tasks in the system. 
Scheduled tasks can be used for running scripts or utilities on schedule. 

Á DNS zone management. Shows whether you can manage the DNS zone of your 
domain. 

Á Java applications management. Shows whether you can install Java applications 
and applets on your web site through the control panel. 

Á Mailing lists management. Shows whether you can use mailing lists provided by the 
GNU Mailman software. 

Á Spam filter management. Shows whether you can use spam filter provided by the 
SpamAssassin software. 

Á Antivirus management. Shows whether you can use server-side antivirus 
protection for filtering incoming and outgoing mail. 
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Á Backup and restore functions. Shows whether you can use the control panel's 
facilities to backup and restore your site. Scheduled and on-demand backups 
are supported. 

Á User interface. Shows what type of Plesk control panel interface you can use - 
standard, desktop, or both. 

Á Desktop management. Shows whether you can customize and manage your 
desktop interface. 

3 Click OK. 

  

 



 

  
 

Once you have registered your domain name, constructed your web site, and 
purchased a hosting package from your hosting service provider, you can: 

Á Publish your site to your web space on the providerôs server, 

Á Deploy databases and applications that your web server will be using, 

Á Secure data transfer with Secure Sockets Layer encryption and restrict access to 
web server resources with password protection. 

 

In this chapter: 

Creating and Publishing Your Site ..................................................................... 27 
Previewing Your Site ......................................................................................... 34 
Deploying Databases ........................................................................................ 34 
Installing Applications ........................................................................................ 37 
Securing Online Transactions on Your Site With SSL Encryption ...................... 40 
Customizing DNS Zone Configuration for Your Domain .................................... 47 
Customizing Web Server Error Messages ......................................................... 51 
Serving Your Site with External Domain Name Servers .................................... 53 
Restricting Access to Web Server's Resources With Password Protection ........ 54 
Organizing Your Site Structure With Subdomains ............................................. 57 
Setting Up Anonymous FTP Access to the Server............................................. 60 
Setting Up Additional Domain Names for a Site (Domain Aliases) ..................... 61 
Hosting Personal Web Pages on Your Web Server ........................................... 64 
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Setting Up And Maintaining Your Web 
Site 



 

 Setting Up And Maintaining Your Web Site 27 

 

Creating and Publishing Your Site 

If your hosting plan includes the Web site creation and management service using 
Sitebuilder, you can create and publish Web sites using Sitebuilder. Or you can create 
your site content (Web pages, scripts and graphic files that compose your site) on your 
home or office computer and then publish it to the server in any of the following ways: 

Á Through FTP connection (most common and easiest way) 

Á Through Plesk File Manager 

Á Through Secure Shell connection (only for users of Linux and FreeBSD operating 
systems) 

Á Through Adobe Dreamweaver or Microsoft FrontPage software (only for users of 
Microsoft Windows operating systems) 

 

In this section: 

Creating and Publishing Web Sites Using Sitebuilder ........................................ 27 
Publishing a Site Through FTP .......................................................................... 28 
Publishing a Site Through Plesk File Manager .................................................. 29 
Publishing a Site Through SSH Connection ...................................................... 30 
Publishing files from Microsoft FrontPage ......................................................... 30 
Publishing a Site From Adobe Dreamweaver .................................................... 33 
 
 

Creating and Publishing Web Sites Using Sitebuilder 

ü To start creating a Web site using Sitebuilder: 

1 On your Home page, click Sitebuilder Wizard. The Sitebuilder wizard 
opens. 

2 Select the Create your site option and click Next at the bottom of the 
screen. 

For further instructions on creating or editing your site, refer to the online Sitebuilder 
Wizard user's guide at  
http://download1.swsoft.com/SiteBuilder/4.0.0/doc/user/en_US/html/index.htm. 
 

http://download1.swsoft.com/SiteBuilder/4.0.0/doc/user/en_US/html/index.htm
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Publishing a Site Through FTP 

ü To upload your site through FTP: 

1 Connect to the server with an FTP client program, using FTP account 
credentials your provider gave you.  

Enable the passive mode if you are behind a firewall. 

2 Upload files and directories that should be accessible through HTTP 

protocol to the httpdocs  directory, and files/directories that should 

be transferred securely over SSL protocol to the httpsdocs  

directory.  

3 Place your CGI scripts into the cgi - bin  directory. 

4 Close your FTP session. 

 

In this section: 

Changing Your FTP Account Credentials .......................................................... 28 
 
 

Changing Your FTP Account Credentials 

To change the user name and password for accessing your FTP account: 

1 On your Home page, click the Setup icon in the Hosting group. 

2 Specify the new FTP login name and password. 

3 Click OK. 
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Publishing a Site Through Plesk File Manager 

To upload files through Plesk File Manager: 

1 Log in to Plesk control panel into your domain administratorôs 
account. 

2 Click the File Manager icon in the Hosting group. 

3 Create and upload files and directories.  

Place the files and directories that should be accessible via HTTP protocol to the 

httpdocs  directory, and files/directories that should be transferred securely over 

SSL protocol to the httpsdocs  directory. Place your CGI scripts into the cgi - bin  

directory. 

Á To create a new directory within your current location, c2ick the  Add New 
Directory button. 

Á To create new files in the required directory, click  Add New File, in the File 
creation section specify the file name, select the Use html template check box, if 
you want file manager to insert some basic html tags to the new file, and click 
OK. A page will open allowing you to enter the content or html-formatted source 
of a new file. After you are done, click OK. 

Á To upload a file from the local machine, click  Add New File, specify the path to 
its location in the File source box (or use the Browse button to locate the file), and 
click OK.  

When you upload web content through File Manager or FTP, your control panel 
automatically sets the appropriate access permissions for files and directories. The 
permissions are represented as three sets of symbols, for example, 'rwx rwx r--'. The 
first set tells what the owner of the file or directory can do with it; the second tells what 
the user group, the file or directory belongs to, can do with the file or directory; the third 
set indicates what other users (the rest of the world, i.e. Internet users visiting a site) 
can do with the file or directory. R means the permission to read the file or directory, W 
means the permission to write to the file or directory, and X means the permission to 
execute the file or look inside the directory. 

To modify permissions for a file or directory, in the Permissions column, click the 
respective hyperlink representing the set of permissions. Modify the permissions as 
desired and click OK. 

To edit the source code of a file, click . 

To edit the Web page in the built-in visual editor (available only to users of Microsoft 

Internet Explorer), click . When editing an HTML file, Plesk opens internal 
WYSIWYG editor by default. If you want to edit the source code of the HTML file, click 
Html. To return back to WYSIWYG mode, click Design. 

To view the file, click . 

To rename a file or directory, click . Type in a new name and click OK. 
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To copy or move a file or directory to another location, select the required file or 

directory using the appropriate check box, and click  Copy/Move. Specify the 
destination for the file or directory to be copied or renamed to, then click Copy to copy, 
or Move to move it. 

To update the file or directory creation date, click  Touch. The time stamp will be 
updated with the current local time. 

To remove a file or directory, select the corresponding check box, and click  Remove 
Selected. Confirm removal and click OK. 

Publishing a Site Through SSH Connection 

If your are using a Linux or FreeBSD operating system on your local computer and 

have access to server shell, use the óscpô command to copy files and directories to the 

server: scp your_file_name login@remoteserver.com:path  to copy files, 

and scp ïr your_directo ry_name login@remoteserver.com:path  to copy 

entire directories. 

After publishing, you will be able to work with files and directories on your account 
using SSH terminal web application integrated in your Plesk control panel (Home >  SSH 
Terminal). 

Publishing files from Microsoft FrontPage 

Microsoft FrontPage deals with two kinds of Web sites: disk-based and server-based. 
In short, a disk-based site is a FrontPage Web site you create on your local hard disk 
and then later publish to a Web server. A server-based site is one you create and work 
with directly on a Web server, without the extra step of publishing. This section 
provides you with instructions on publishing only disk-based web sites. 

You can publish disk-based web sites either through FTP or HTTP. If your server is 
running FrontPage Server Extensions, you would publish your site to an HTTP location. 
For example: http://your-domain.com/MyWebSite. If your server supports FTP, you 
would publish to an FTP location. For example: ftp://ftp.your-domain.com/myFolder. 

To find out which publishing method your server supports, contact your hosting 
company, or your IT department. 

After publishing, you can manage your site through FrontPage Server Extensions.  

To access FrontPage Server Extensions management interface: 

1 Log in to Plesk. 

2 To manage a site, which is not protected by SSL, click FP Webadmin. To 
manage an SSL-enabled site, click FP-SSL Webadmin. 

3 Type your FrontPage administratorôs login name and password, and 
click OK. 

mailto:login@remoteserver.com:path
mailto:login@remoteserver.com:path
http://your-domain.com/MyWebSite
ftp://ftp.your-domain.com/myFolder


 

 Setting Up And Maintaining Your Web Site 31 

 

For instructions on using FrontPage server extensions, see online help (FP Webadmin > 
Help) or visit Microsoft web site.  

In this section: 

Publishing Sites From Microsoft FrontPage Through FTP ................................. 31 
Publishing Sites From Microsoft FrontPage Through HTTP .............................. 32 
 
 

Publishing Sites From Microsoft FrontPage Through FTP 

If you are publishing from a computer at work, ask your IT department, help desk, or 
network administrator if you are allowed to publish with FTP beyond a firewall. Also ask 
if you need to install special software that allows you to publish beyond the firewall. 

ü To publish files through FTP: 

1 Open Microsoft FrontPage. 

2 Open a Microsoft  FrontPage Web site: open File menu and select the 
Open Site item. 

3 Go to Remote Web site view: click the Web Site tab, and then the Remote 
Web Site button at the bottom of the window. 

4 Set up your Remote Web Site Properties: 

Á Click the Remote Web Site Properties button in the upper-right corner of the 
window. 

Á Select FTP as the remote Web server. 

Á In the Remote Web site location box, type your host name (e.g., ftp://ftp.your-
domain.com) 

Á In the FTP directory box, type your FTP directory if your hosting company 
provided one. Leave it blank if they did not specify one. 

Á Select the Use Passive FTP check box if your computer or network is protected by 
a firewall.  

5 Click OK to connect to the remote site.  

The Remote Web site view will show files that you have in your local and remote 
sites. 

6 Click the Publish Web site button in the lower-right corner of the window. 

 
 

ftp://ftp.your-domain.com/
ftp://ftp.your-domain.com/
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Publishing Sites From Microsoft FrontPage Through HTTP 

ü To publish files through HTTP on a server that supports FrontPage Server Extensions: 

1 Open your FrontPage program. 

2 Open a FrontPage Web site: open File menu and select the Open Site 
item. 

3 Go to Remote Web site view: click the Web Site tab, and then the Remote 
Web Site button at the bottom of the window. 

4 Click the Remote Web Site Properties button in the upper-right corner of 
the window. 

5 On the Remote Web Site tab, under Remote Web server type, click FrontPage or 
SharePoint Services. 

6 In the Remote Web site location box, type the Internet address, including 
the protocol, of the remote Web site that you want to publish folders 
and files to ð for example, http://www.your-domain.com ð or click 
Browse to locate the site. 

7 Do any of the following:  

Á To use Secure Sockets Layer (SSL) for establishing a secure communications 
channel to prevent the interception of critical information, click Encryption 
connection required (SSL). To use SSL connections on your Web server, the 
server must be configured with a security certificate from a recognized certificate 
authority. If the server does not support SSL, clear this check box. Otherwise, 
you will not be able to publish folders and files to the remote Web site. 

Á To remove specific types of code from Web pages as they are being published, 
on the Optimize HTML tab, select the options you want. 

Á To change the default options for publishing, on the Publishing tab, select the 
options you want. 

8 Click OK to connect to the remote site.  

The Remote Web site view will show files that you have in your local and remote sites. 

9 Click the Publish Web site button in the lower-right corner of the window. 
 

http://www.your-domain.com/
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Publishing a Site From Adobe Dreamweaver 

Before publishing a site from Dreamweaver, you need to define the site properties, that 
is, you need to tell Dreamweaver where your site files are located on your computer, 
and to specify the server to which you want to publish the site. 

ü To define a site in Dreamweaver: 

1 From the Site menu, choose New Site. The Site Definition screen opens. 

2 Click the Advanced tab. 

3 In the Local Info category, specify the following: 

Á Site name. This will show in Web browserôs title bar. 

Á Local root folder. This is the folder on your computer where all of your site files 

are stored. For example c: \ My Site  

Á Default images folder. Specify the folder where your siteôs graphic files are stored. 

For example c: \ My Site \ images  

Á HTTP address. Specify your domain name. For example, http://your -

domain.com  

4 From the Category menu, select the Remote Info item. 

5 From the Access menu, select the FTP option. Most likely, your server 
supports publishing through FTP (File Transfer Protocol, commonly 
used for transferring files over the Internet). 

6 Specify the following settings: 

Á FTP host. Type your FTP host name without the ftp://  prefix. For example, 

your - domain.com . 

Á Host directory. Specify the directory on the server where your site will reside. In 

most cases, this is httpdocs . 

Á Login and password. Specify the login name and password that your provider 
gave you. 

Á Use passive FTP. Select this option only if your computer is behind a firewall. 

7 To ensure that you specified the correct login and password, and that 
Dreamweaver can connect to the server, click the Test button. 

8 To save the settings, click OK. 

 

ü To publish your site: 

1 Open your site in Dreamweaver. 

2 From the Site menu, select the Put option (or press Ctrl+Shift+U 
simultaneously).  

 

http://your-domain.com/
http://your-domain.com/
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Previewing Your Site 

Once you published your site to your web space, you may want to make sure that it 
functions properly in the actual hosting environment. You can preview your site through 
your favorite Web browser, even if the information on your domain name has not yet 
propagated in the Domain Name System. Note that Adobe Flash and CGI scripts will 
not work during preview. Also, site preview does not work for Web sites and Web 
pages that include absolute paths to other files (like <a 
href="http://domain.tld/image.gif">). 

To preview your site, on your Home page, click Site Preview in the Hosting group. 
 

Deploying Databases 

If your web server incorporates data processing applications or is designed to generate 
web pages dynamically, you will likely need a database for storing and retrieving data. 
You can either create a new database for your site or import the data from your 
previously backed up MySQL or PostgreSQL database. 

In this section: 

Creating or Importing a Database ...................................................................... 35 
Creating a Database User Account ................................................................... 36 
Changing Password of a Database User ........................................................... 36 
Removing a Database User Account ................................................................. 36 
Removing a Database ....................................................................................... 36 
 
 

http://domain.tld/image.gif
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Creating or Importing a Database 

To create a new database on your hosting account: 

1 On your Home page, click Databases. 

2 Click Add New Database. 

3 Enter a name for the database.  

We recommend that you choose a name that starts with a Latin alphabet symbol 
and comprises only alphanumeric and underscore symbols (up to 64 symbols).  

4 Select the database type that you are going to use: MySQL or 
PostgreSQL. Click OK. 

5 To set up database administratorôs credentials, click Add New Database 
User. 

6 Type a user name and a password that will be used for accessing the 
contents of the database. 

7 Click OK.   

 

To import an existing database: 

1 On your Home page, click Databases. 

2 Click Add New Database. 

3 Enter a name for the database.  

We recommend that you choose a name that starts with a Latin alphabet symbol 
and comprises only alphanumeric and underscore symbols (up to 64 symbols).  

4 Select the database type that you are going to use: MySQL or 
PostgreSQL. Click OK. 

5 To set up database administratorôs credentials, click Add New Database 
User. 

6 Type a user name and a password that will be used for accessing the 
contents of the database. Click OK. 

7 Click the DB WebAdmin icon in the Tools group.  

An interface to phpMyAdmin (or phpPgAdmin) database management tool will open 
in a separate browser window. 

8 Click on the Query window icon in the left frame. 

9 Click the Import files tab. 

10 Select the text file that contains the data and click Go. 

11 Click the Insert data from a text file link. 

To manage your databases and their contents, use your favorite MySQL or 
PostgreSQL client or the web based database management tool accessible from Plesk 
control panel (Home > Databases > Database name > DB WebAdmin).  
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Creating a Database User Account 

If you collaborate with other people on managing your web site and wish to give them 
access to the database, you should create separate user accounts for them. 

ü To create a database user account:  

1 Go to Databases > database name and click Add New Database User. 

2 Type a user name and a password that will be used for accessing the 
contents of the database. Click OK. 

 
 

Changing Password of a Database User 

ü To change password for a database user: 

1 Go to Databases > database name > database userôs name. 

2 Type a new password and click OK. 

 
 

Removing a Database User Account 

ü To remove a database user account:  

1 Go to Databases > database name.  

2 Select a check box corresponding to the user account that you wish to 
remove. 

3 Click  Remove Selected. Next, confirm removing and click OK.  

 
 

Removing a Database 

ü To remove a database with its contents: 

1 On your Home page, click Databases in the Services group. 

2 Select a check box corresponding to the database that you wish to 
remove.  

If the required check box appears grayed out, this means that this database is used 
by a site application and you can remove it only by uninstalling the respective 
application. 

3 Click  Remove Selected. Confirm removal and click OK. 
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Installing Applications 

To enhance your web site with valuable features, such as guest books, forums, hit 
counters, photo galleries, and e-commerce solutions, you can install the respective 
applications from Plesk Application Vault (Home > Web Applications). The number and 
variety of available applications depend on your providerôs policy and your hosting plan. 

ü To install an application on your site: 

1 On your home page, click Web Applications.  

A list of applications installed on your site will be displayed.  

2 Click Add New Application icon in the Tools group. 

 A list of site applications available for installation will be displayed. 

3 To specify the site where you want to install and deploy an 
application, select it in the Target domain menu. 

4 To specify which application you wish to install, select an option 
button corresponding to the application of your choice.  

5 Click  Install. 

6 Specify whether you wish to create a hyperlink to the applicationôs 
interface and place it on your Home page in the control panel. 

7 Specify the installation preferences and other information that may be 
required by the application (the requirements may vary), and click OK, 
when finished. 

8 If you have chosen to create a hyperlink button inside your Plesk 
control panel, specify its properties: 

Á Type the text that will show on your button in the Button label box. 

Á Choose the location for your button. To place it in the right frame of your Home 
page, select the Domain Administration page value as the location. To place it in 
the left frame (navigation pane) of your control panel, select the Navigation pane 
value.    

Á Specify the priority of the button. Plesk will arrange your custom buttons on the 
control panel in accordance with the priority you define: the lower the number ï 
the higher is priority. Buttons are placed in the left-to-right order. 

Á To use an image for a button background, type the path to its location or click 
Browse to browse for the desired file. It is recommended that you use a 16x16 
pixels GIF or JPEG image for a button to be placed in the navigation pane, and 
32x32 pixels GIF or JPEG image for buttons placed in the main frame. 

Á Type the hyperlink to be attached to the button into the URL box. 

Á Using the check boxes, specify whether to include the data, such as domain id 
and domain name to be transferred within the URL. These data can be used for 
processing by external web applications. 

Á In the Context help tip contents input field, type in the help tip that will be displayed 
when you hover the mouse pointer over the button. 
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Á Select the Open URL in the Control Panel check box if you wish the destination URL 
to be opened in the control panel's right frame, otherwise leave this check box 
unchecked to open the URL in a separate browser window. 

Á If you wish to make this button visible to the e-mail users whom you granted 
access to control panel, select the Visible to all sub-logins check box. 

Á Click OK to complete creation. 

Now the application is installed and you can insert a link to this application into the web 
pages of your site, for example, on your home page. Otherwise, you and your users will 
have to access this application by typing its URL, which can be long enough to 
remember. 

To access the web interface of an application, do any of the following: 

Á Type the URL in your browser. For example: http://your-domain.com/forum/. 

Á Go to Home > Web Applications, and click an icon , corresponding to the 
application. 

Á If you chose to add a hyperlink button to your Plesk control panel during installation 
of an application, then on your Home page, click the respective button in the 
Custom buttons group or navigation pane. 

To reconfigure an application, change the application administratorôs password, or to 
install a license key for a commercial application, go to Home > Web Applications, and 

click an icon , corresponding to the application. 

To upgrade an application to a newer version (if it is available on the server), go to 
Home > Web Applications, and click a corresponding shortcut in the U column. 

To remove an application, go to Home > Web Applications, and select a check box 

corresponding to the application that you no longer need. Then click  Remove 
Selected. The application and its databases will be removed from the server. 

In this section: 

Installing Java Web Applications ....................................................................... 39 
Installing Ruby Web Applications ...................................................................... 39 
 
 

http://your-domain.com/forum/
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Installing Java Web Applications 

You can install Java Web application packages in the Web archive format (WAR). 
These Java applications are not distributed with Plesk, therefore you should obtain 
them separately. 

ü To install a Java Web application: 

1 From your Home page, go to Web Applications > Java Applications tab and 
click Switch On. 

This will start the Tomcat service, which provides an environment for Java code to 
run in cooperation with a web server. 

2 Click Install New Application. 

3 Specify the path to an application package you wish to install (this 
can be an application package in WAR format saved on your 
computerôs hard drive), or click Browse to navigate to it, then click OK. 

Now the application is installed and the respective entry is added to the list of installed 
Java applications (Web Applications > Java Applications). 

ü To access the web interface of a Java Web application, do any of the following: 

Á From your Home page, go to Web Applications > Java Applications tab, and click a 
respective hyperlink in the Path column. 

Á Type the URL in your browser. For example: http://your-
domain.com:9080/storefront/. 

ü To stop, start or restart a Java Web application: 

1 From your Home page, go to Web Applications > Java Applications tab. A 
list of installed applications will open. 

2 Locate an application on the list, and use the icons in the right part of 
the list to perform the required operations: 

Á To start an application, click the icon . 

Á To stop an application, click the icon . 

Á To restart an application, click the icon . 

ü To uninstall a Java Web application: 

1 From your Home page, go to Web Applications > Java Applications tab. 

2 Select a check box corresponding to the application that you no 

longer need. Click  Remove Selected, confirm the removal and click OK.  

The application will be uninstalled and its databases removed from the server. 

Installing Ruby Web Applications 

You can install on your site custom Web applications developed in the Ruby 
programming language. 

http://your-domain.com:9080/storefront/
http://your-domain.com:9080/storefront/
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ü To install on your site an application written in Ruby: 

1 On your Home page, under Hosting, click Setup. 

2 Select the CGI and FastCGI check boxes, and click OK. 

3 Connect to your FTP account, change to the /htdocs  directory, and 

create a subdirectory where the application files will reside. Let's call 

this directory  your_application , for illustration purposes. 

4 Upload the application files to the htdocs/your_application  

directory. 

5 Create a file with name .htaccess  in this directory, open it with a 

text editor of your choice and add the following lines into the file:  

RewriteEngine On RewriteRule ^$ /public/index.html [L] 

RewriteCond %{REQUEST_URI} !^ /your_application/public  

RewriteRule ^(.*)$ /public/$1 [L] RewriteCond 

%{REQUEST_FILENAME} !- f  RewriteRule ^(.*)$ 

public/dispatch.fcgi/$1 [QSA,L]  

6 Save the file. 

7 Remove the file your_application/public/.htaccess  

8 Open the file your_application/public/dispat ch.fcgi  with a 

text editor and put the following lines there: #!/usr/bin/ruby  

9 Save the file. 

 

Now the web application will be accessible at the following URL: http://your-
domain.com/your_application.  

Securing Online Transactions on Your 
Site With SSL Encryption 

If you are running an e-commerce business, you need to secure transactions between 
your customers and your site. To prevent the valuable data, such as credit card 
numbers and other personally identifiable information from stealing, you should use the 
Secure Sockets Layer protocol, which encrypts all data and transfers them securely 
over the SSL connection. And even if someone intercepts the data for malicious intent, 
they will not be able to decrypt and use them. 

To implement the Secure Sockets Layer protocol on your web server, you should 
purchase an SSL certificate from a reputable certificate vendor (these vendors are 
called Certificate Authorities), and then install this certificate on your site. To enable 
SSL protection, you must host your site on a dedicated IP address, which is not shared 
among other web sites. 

http://your-domain.com/your_application
http://your-domain.com/your_application
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There are numerous certificate authorities to choose from. When considering one, pay 
attention to reputation and credibility of the CA. Knowing how long they have been in 
business and how many customers they have will help you make the right choice. 

Your Plesk control panel provides facilities for purchasing SSL certificates from 
GeoTrust, Inc. 

In this section: 

Obtaining and Installing SSL Certificates from GeoTrust, Inc. or GoDaddy ....... 42 
Obtaining and Installing SSL Certificates from Other Certification Authorities.... 44 
Creating and Installing Free Self-signed SSL Certificate ................................... 45 
Uninstalling a Certificate from Your Site ............................................................ 46 
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Obtaining and Installing SSL Certificates from 
GeoTrust, Inc. or GoDaddy 

ü To purchase an SSL certificate through MyPleskCom online store and secure your 
site: 

1 Go to Certificates and click Add New Certificate. 

2 Specify the certificate properties: 

Á Certificate name. This will help you identify this certificate in the repository. 

Á Encryption level. Choose the encryption level of your SSL certificate. We 
recommend that you choose a value more than 1024 bit. 

Á Specify your location and organization name. The values you enter should not 
exceed the length of 64 symbols. 

Á Specify the domain name for which you wish to purchase an SSL certificate. 
This should be a fully qualified domain name. Example: www.your-domain.com 

Á Enter the domain administrator's e-mail address. 

3 Make sure that all the provided information is correct and accurate, as 
it will be used to generate your private key. Click Buy Certificate.  

Your private key and certificate signing request will be generated ð do not delete 
them. MyPlesk.com login page will open in a new browser window. 

4 Register or login to an existing MyPlesk.com account and you will be 
taken step by step through the certificate purchase procedure. 

5 Choose the type of certificate that you wish to purchase. 

6 Click Proceed to Buy and order the certificate.  

7 In the Approver E-Mail drop-down box, please select the correct 
Approver e-mail.  

The approver e-mail is an e-mail address that can confirm that certificate for 
specific domain name was requested by an authorized person. 

Once your certificate request is processed, you will be sent a confirmation e-mail. 
After you confirm, the SSL certificate will be sent to your e-mail. 

8 When you receive your SSL certificate, save it on your local machine 
or network. 

9 Return to the SSL Certificates repository (Home > Certificates). 

10 Click Browse and navigate to the location of the saved certificate.  

11 Select the saved certificate, and then click Send File.  

This will upload and install the certificate against the corresponding private key. 

12 Return to your Home page and click Setup in the Hosting group. 

13 Select the SSL certificate that you wish to install from the Certificate 
drop-down box.  

http://www.your-domain.com/
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If there is no Certificate drop-down box on the screen, this means that you are on a 
shared hosting account; therefore, you need to upgrade your hosting package and 
purchase a dedicated IP address from your hosting provider. 

14 Select the SSL support check box and click OK. 
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Obtaining and Installing SSL Certificates from Other 
Certification Authorities 

ü To secure your site with an SSL certificate from other certificate authorities: 

1 Go to Certificates and click Add New Certificate. 

2 Specify the certificate properties: 

Á Certificate name. This will help you identify this certificate in the repository. 

Á Encryption level. Choose the encryption level of your SSL certificate. We 
recommend that you choose a value more than 1024 bit. 

Á Specify your location and organization name. The values you enter should not 
exceed the length of 64 symbols. 

Á Specify the domain name for which you wish to purchase an SSL certificate. 
This should be a fully qualified domain name. Example: www.your-domain.com 

Á Enter the domain administrator's e-mail address. 

3 Make sure that all the provided information is correct and accurate, as 
it will be used to generate your private key. Click Request. 

 Your private key and certificate signing request will be generated and stored in the 
repository. 

4 Click , download the certificate signing request (CSR) file and save 
it on your machine. 

5 Once downloaded, open the file in a text editor, copy the text that 
starts with the line -----BEGIN CERTIFICATE REQUEST----- and ends with the 
line -----END CERTIFICATE REQUEST----- to the clipboard. Be sure to include 
the lines -----BEGIN CERTIFICATE REQUEST----- and  -----END CERTIFICATE 
REQUEST----- into your certificate signing request because they are part 
of it. 

6 Using your favorite mail client software, create a new e-mail message 
and paste the text from the clipboard.  

7 Send this message to the Certification Authority that will create an 
SSL certificate in accordance with the information you supplied.  

8 When you receive your SSL certificate, save it on your local machine 
or network. 

9 Return to the SSL Certificates repository (Home > Certificates). 

10 Click Browse in the middle of the page and navigate to the location of 
the saved certificate.  

11 Select it, and then click Send File.  

This will upload and install the certificate against the corresponding private key. 

12 Return to your Home page and click Setup in the Hosting group. 

13 Select the SSL certificate that you wish to install from the Certificate 
drop-down box.  

http://www.your-domain.com/
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If there is no Certificate drop-down box on the screen, this means that you are on a 
shared hosting account; therefore, you need to upgrade your hosting package and 
purchase a dedicated IP address from your hosting provider. 

14 Select the SSL support check box and click OK. 
 

Creating and Installing Free Self-signed SSL Certificate 

If you do not feel like paying money for SSL certificates, but still need to secure your 
site, you can create a self-signed certificate and install it on your web server. This will 
provide data encryption; however, your customersô browsers will show warning 
messages telling that your certificate is not issued by a recognized authority. Thus, 
using self-signed certificates is not recommended as it will not instill confidence in 
customers, and is likely to adversely affect your online sales. 

ü To secure your site with a self-signed SSL certificate: 

1 Go to Certificates and click Add New Certificate. 

2 Specify the certificate properties: 

Á Certificate name. This will help you identify this certificate in the repository. 

Á Encryption level. Choose the encryption level of your SSL certificate. We 
recommend that you choose a value more than 1024 bit. 

Á Specify your location and organization name. The values you enter should not 
exceed the length of 64 symbols. 

Á Specify the domain name for which you wish to generate an SSL certificate. 
This should be a fully qualified domain name. Example: www.your-domain.com. 

Á Enter the domain administrator's e-mail address. 

3 Click Self-Signed.  

Your certificate will be generated and stored in the repository. 

4 Return to your Home page and click Setup in the Hosting group. 

5 Select the self-signed SSL certificate from the Certificate drop-down 
box.  

If there is no Certificate drop-down box on the screen, this means that you are on a 
shared hosting account; therefore, you need to upgrade your hosting package and 
purchase a dedicated IP address from your hosting provider. 

6 Select the SSL support check box and click OK. 
 

http://www.your-domain.com/
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Uninstalling a Certificate from Your Site 

ü To uninstall a certificate from your site and disable SSL protection: 

1 Make sure that the certificate you want to remove is not used at the 
moment.  

1. On your Home page, click Setup.  

2. The Certificate drop-down box indicates which SSL certificate is 
currently used.  

3. If the certificate that you want to remove is currently in use, 
you should first release it by selecting another certificate in 
the Certificate drop-down box, and clicking OK.  

2 Remove the certificate from repository.  

1. To permanently remove the certificate from repository, on your 
Home page, click Certificates in the Services group.  

2. Select a check box corresponding to the certificate that you no 

longer need and click  Remove Selected. Confirm removal and 
click OK. 

3 Disable SSL support if you no longer need it.  

1. On your Home page, click Setup.  

2. Clear the SSL support check box and click OK. 
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Customizing DNS Zone Configuration for 
Your Domain 

Your control panel automatically creates DNS zone for your domain in accordance with 
the configuration preset defined by your provider. The domain name should work fine 
with the automatic configuration, however if you need to perform custom modifications 
in the domain name zone, you can do that through your control panel. 

To view the resource records in a DNS zone of your domain, click DNS Settings in the 
Services group. A screen will show all resource records for your domain. 

To learn about modifying resource records in the DNS zone of a domain alias, refer to 
the Setting Up Additional Domain Names for a Site (Domain Aliases) (on page 61) 
section. 

In this section: 

Adding Resource Records ................................................................................. 48 
Modifying Resource Records ............................................................................ 49 
Removing Resource Records ............................................................................ 49 
Restoring the Original Zone Configuration ......................................................... 50 
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Adding Resource Records 

To add a new resource record to the zone: 

1 Click the DNS icon in the Services group. 

2 Click the Add New Record icon in the Tools group. 

3 Select a resource record type, and specify the appropriate data:  

Á For an A record you will need to enter the domain name for which you wish to 
create an A record. If you are simply defining an A record for your domain, then 
you should leave the available field empty. If you are defining an A record for a 
name server then you will need to input the appropriate entry for the given name 
server (ie. ns1). Then, you need to enter the appropriate IP address to which to 
associate the domain name. 

Á For a NS record, you will need to enter the domain name for which you wish to 
create the NS record. If you are defining an NS record for your domain, then you 
will leave the available field blank. Then enter the appropriate name server 
name in the field provided. You will need to enter the complete name (i.e. 
ns1.mynameserver.com). 

Á For a MX record, you will need to enter the domain for which you are creating 
the MX record. For your domain, you would simply leave the available field 
blank. You will then need to enter your mail exchanger, this is the name of the 
mail server. If you are running a remote mail server named 
'mail.myhostname.com' then you would simply enter 'mail.myhostname.com' 
into the field provided. You will then need to set the priority for the mail 
exchanger. Select the priority using the drop-down box: 0 is the highest and 50 
is the lowest. Keep in mind you would also need to add the appropriate A 
record, and/or CNAME if applicable for the remote mail exchange server. 

Á For a CNAME record, you will need to first enter the alias domain name for 
which you wish to create the CNAME record. You then need to enter the domain 
name within which you want the alias to reside. Any domain name can be 
entered. It does not need to reside on the same server. 

Á For a PTR record you will first enter the IP address/mask for which you wish to 
define the pointer. Then enter the appropriate domain name for this IP to be 
translated to. 

Á For a TXT record, you will be able to enter an arbitrary text string, which could 
be a description or an SPF record. 

4 Click OK to submit the data. 
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Modifying Resource Records 

To modify the properties of a resource record: 

1 Click the DNS icon in the Services group. 

2 Click the hyperlink in the Host column corresponding to the resource 
record you want to modify. 

3 Modify the record as required and click OK. 

 

To modify entries in the Start of Authority (SOA) record for a domain: 

1 Click the DNS icon in the Services group. 

2 Click SOA Preferences. 

3 Specify the desired values: 

Á TTL. This is the amount of time that other DNS servers should store the record in 
a cache. Plesk sets the default value of one day. 

Á Refresh. This is how often the secondary name servers check with the primary 
name server to see if any changes have been made to the domain's zone file. 
Plesk sets the default value of three hours. 

Á Retry. This is the time a secondary server waits before retrying a failed zone 
transfer. This time is typically less than the refresh interval. Plesk sets the 
default value of one hour. 

Á Expire. This is the time before a secondary server stops responding to queries, 
after a lapsed refresh interval where the zone was not refreshed or updated. 
Plesk sets the default value of one week. 

Á Minimum. This is the time a secondary server should cache a negative response. 
Plesk sets the default value of three hours. 

4 Click OK. 
 

Removing Resource Records 

ü To remove a resource record from the zone: 

1 Click DNS Settings in the Services group. 

2 Select a check box corresponding to the record you wish to remove.  

3 Click  Remove Selected. Confirm removal and click OK. 
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Restoring the Original Zone Configuration 

To restore the original zone configuration in accordance with the configuration preset 
defined by your provider: 

1 Click the DNS icon in the Services group. 

2 In the IP address drop-down box, select the IP address to be used for 
restoring the zone, specify whether a www alias is required for the 
domain, and click the Default button. The zone configuration will be 
recreated. 
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Customizing Web Server Error Messages 

When visitors coming to your site request pages that the web server cannot find, the 
web server generates and displays a standard HTML page with an error message. The 
standard error messages may inform of problems, but they do not usually say how to 
resolve them or how to get the lost visitor on his way, and they also look dull. 

You may want to create your own error pages and use them on your web server. With 
Plesk you can customize the following error messages: 

Á 400 Bad File Request. Usually means the syntax used in the URL is incorrect (for 
example, uppercase letter should be lowercase letter; wrong punctuation marks). 

Á 401 Unauthorized. Server is looking for some encryption key from the client and is not 
getting it. Also, wrong password may have been entered. 

Á 403 Forbidden/Access denied. Similar to 401; a special permission is needed to access 
the site - a password and/or username if it is a registration issue. 

Á 404 Not Found. Server cannot find the requested file. File has either been moved or 
deleted, or the wrong URL or document name was entered. This is the most 
common error. 

Á 405 Method Not Allowed. The method specified in the Request-Line is not allowed for 
the resource identified by the Request-URI. 

Á 406 Not Acceptable. The resource identified by the request is only capable of 
generating response entities which have content characteristics not acceptable 
according to the accept headers sent in the request. 

Á 407 Proxy Authentication Required. This code is similar to 401 (Unauthorized), but 
indicates that the client must first authenticate itself with the proxy.  

Á 412 Precondition Failed. The precondition given in one or more of the request-header 
fields evaluated to false when it was tested on the server. This response code 
allows the client to place preconditions on the current resource metainformation 
(header field data) and thus prevent the requested method from being applied to a 
resource other than the one intended. 

Á 414 Request-URI Too Long. The server is refusing to service the request because the 
Request-URI is longer than the server is willing to interpret. This rare condition is 
only likely to occur when a client has improperly converted a POST request to a 
GET request with long query information, when the client has descended into a URI 
"black hole" of redirection (e.g., a redirected URI prefix that points to a suffix of 
itself), or when the server is under attack by a client attempting to exploit security 
holes present in some servers using fixed-length buffers for reading or manipulating 
the Request-URI. 

Á 415 Unsupported Media Type. The server is refusing to service the request because 
the entity of the request is in a format not supported by the requested resource for 
the requested method. 

Á 500 Internal Server Error. Could not retrieve the HTML document because of server-
configuration problems. 

Á 501 Not Implemented. The server does not support the functionality required to fulfill 
the request. This is the appropriate response when the server does not recognize 
the request method and is not capable of supporting it for any resource. 
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Á 502 Bad Gateway. The server, while acting as a gateway or proxy, received an invalid 
response from the upstream server it accessed in attempting to fulfill the request. 

 

To configure Pleskôs web server to show your custom error pages: 

1 Switch on support for custom error documents through Plesk. On your 
Home page, click the domain name you need, and then click Setup. 
Select the Custom Error Documents check box. Click OK. 

2 Connect to your FTP account on the Plesk server, and go to the 

error_docs  directory. 

3 Edit or replace the respective files. Be sure to preserve the correct file 
names: 

Á 400 Bad File Request - bad_request.html  

Á 401 Unauthorized - unauthorized.html  

Á 403 Forbidden/Access denied - forbidden.html  

Á 404 Not Found - not_fo und.html  

Á 405 Method Not Allowed -  method_not_allowed.html  

Á 406 Not Acceptable -  not_acceptable.html  

Á 407 Proxy Authentication Required -  

proxy_authentication_required.html  

Á 412 Precondition Failed -  precondition_failed.html  

Á 414 Request-URI Too Long -  request - uri_too_long.html  

Á 415 Unsupported Media Type -  unsupported_media_type.html  

Á 500 Internal Server Error - internal_server_error.html  

Á 501 Not Implemented -  not_implemented.html  

Á 502 Bad Gateway -  bad_gateway.html  

4 Wait for a few hours till your Web server is restarted. After that, the 
Web server will start using your error documents. 
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Serving Your Site with External Domain 
Name Servers 

If you host a web site on this server and have a standalone DNS server acting as a 
primary (master) name server for your site, you may want to set up your control panel's 
DNS server to function as a secondary (slave) name server: 

1 Go to DNS Settings. 

2 Click Switch DNS Service Mode in the Tools group. 

3 Click Add Record, specify the IP address of the primary (master) DNS 
server, and click OK. 

 

ü To make the control panelôs DNS server act as a primary for a zone: 

1 Click DNS Settings. 

2 Click Switch DNS Service Mode in the Tools group. The original resource 
records for the zone will be restored. 

 

If you host a web site on this server and rely entirely on other machines to perform the 
Domain Name Service for your site (there are two external name servers - a primary 
and a secondary), switch off the control panelôs DNS service for each site served by 
external name servers: 

1 Click DNS Settings. 

2 Click Switch Off the DNS Service in the Tools group. Turning the DNS 
service off for the zone will refresh the screen, so that only a list of 
name servers remains. 

Note: The listed name server records have no effect on the system. They are only 
presented on the screen as clickable links to give you a chance to validate the 
configuration of the zone maintained on the external authoritative name servers. 

ü To validate the configuration of a zone maintained on authoritative name servers: 

1 Click DNS Settings. 

2 Add the entries pointing to the appropriate name servers that are 
authoritative for the zone to the list of DNS records: click Add Record, 
specify a name server, and click OK. Repeat this for each name server 
you would like to test.  

3 The records will appear in the list. 

4 Click on the records that you have just created. Plesk will retrieve the 
zone file from a remote name server and check the resource records 
to make sure that domainôs resources are properly resolved.  

5 The results will be interpreted and displayed on the screen. 
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Restricting Access to Web Server's 
Resources With Password Protection 

If you have directories in your site that only authorized users should see, restrict 
access to these directories with password protection. 

In this section: 

Protecting a Resource ....................................................................................... 55 
Adding and Removing Authorized Users ........................................................... 56 
Unprotecting a Resource ................................................................................... 57 
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Protecting a Resource 

To password protect a directory in your site and to specify authorized users: 

1 On your Home page, click the Directories icon in the Hosting group. 

2 Click Add New Directory. 

3 Specify the path to the directory that you wish to password protect.  

This can be any directory existing in your site, for example: /private . If the 

directory that you would like to protect has not yet been created, specify the path 
and the directory name ï Plesk will create it for you. 

4 Specify in what location (also called document root) your password 
protected directory resides or will reside.  

For example: 

Á To protect the httpdocs/private  directory, type '/private' in the Directory name 

box and select the Non-SSL check box. 

Á To protect the httpsdocs/private  directory, type '/private' in the Directory 

name box and select the SSL check box. 

Á To protect your CGI scripts stored in the cgi - bin  directory, leave the '/' value 

in the Directory name box and select the cgi-bin check box. Make sure there are 
no white spaces after the slash symbol; otherwise, a protected directory will be 
created with the name consisting of white spaces.  

5 In the Header Text box, type a resource description or a welcoming 
message that your users will see when they visit your protected area.  

6 Click OK.  

The directory you specified will be protected. 

7 To add authorized users, click Add New User. 

8 Specify the login name and password that will be used for accessing 
the protected area.  

The password should be from 5 to 14 symbols in length.  

9 Click OK. 

10 To add more authorized users for this protected resource, repeat the 
steps 7 and 8. 
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Adding and Removing Authorized Users 

To add an authorized user of a protected directory: 

1 On your Home page, click the Directories icon in the Hosting group. 

2 Click on the name of the directory you need. 

3 Click the Add New User icon. 

4 Specify the login name and password that will be used for accessing 
the protected area.  

The password should be from 5 to 14 symbols in length. 

5 Click OK. 

 

To change password for an authorized user of a protected directory: 

1 On your Home page, click the Directories icon in the Hosting group. 

2 Click on the name of the directory you need.  

A list of authorized users will open. 

3 Click on the userôs name. 

4 Specify the new password and re-type it for confirmation. 

5 Click OK. 

 

To revoke a permission to access the protected directory from a user: 

1 On your Home page, click the Directories icon in the Hosting group. 

2 Click on the name of the directory you need.  

A list of authorized users will open. 

3 Select a check box corresponding to the userôs name. 

4 Click  Remove Selected.  

5 Confirm the operation and click OK. 
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Unprotecting a Resource 

To remove password protection and make the resource available to the public: 

1 On your Home page, click the Directories icon in the Hosting group.  

A list of password protected directories will open. 

2 Select a check box corresponding to the name of the directory, from 
which you want to remove protection. 

3 Click  Remove Selected.  

The protection will be removed and the contents of the directory will be accessible to 
the public without restrictions. 

Organizing Your Site Structure With 
Subdomains 

Subdomains are additional domain names that enable you to: 

Á Organize logically the structure of your web site 

Á Host additional web sites or parts of your web site on the same server without the 
need to pay for registration of additional domain names 

An example of using subdomains: 

You have a web site your-product.com dedicated to promoting your software product. 
For publishing userôs guides, tutorials and list of frequently asked questions, you can 
organize the subdomain 'userdocs' so that your users will be able to access online user 
documentation directly by visiting the domain name userdocs.your-product.com. 

In this section: 

Setting Up Subdomains ..................................................................................... 58 
Removing Subdomains ..................................................................................... 59 
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Setting Up Subdomains 

To set up a subdomain: 

1 On your Home page, click the Subdomains icon. 

2 Click the Add New Subdomain icon. 

3 Type the subdomain name as desired.  

This can be, for example, a topic of your site, organization department, or any other 
combination of letters, numbers and hyphens (up to 63 characters in length). The 
subdomain name must begin with an alphabet character. Subdomain names are 
case insensitive.   

4 If this subdomain will hold a part of your own Web site that you 
manage on your own, leave the Use the FTP user account of the parent domain 
option selected. If this subdomain will hold a separate web site that 
will belong to or will be managed by another person, select the Create a 
separate user account for this subdomain option, and specify the login name 
and password that will be used for accessing the web space through 
FTP and publishing web site content. 

5 If this subdomain will require secure transactions, select the SSL 
support checkbox.  

Then, the SSL certificate installed under the parent domain will be used for 
encrypting transactions. By default, when you publish the site, you need to upload 
the web content that should be accessible via secure connections to the 

httpsdocs  directory, and the content that should be accessible via plain HTTP, to 

the httpdocs  directory. For your convenience, you can choose to publish all 

content through a single location ï httpdocs  directory. To do this, select the 

option Use a single directory for housing SSL and non-SSL content. 

6 Specify the programming languages in which your web site is 
developed.  

Otherwise, your web site may not function properly. For example, if your web site is 
written mainly in ASP and uses some applications written in PHP, such as those 
from the Application Vault, select the ASP support and PHP support check boxes. 

7 If you wish to limit the amount of disk space that can be occupied by 
web content under this subdomain, type the desired value in 
megabytes into the Hard disk quota box.  

When the specified limit is exceeded, you will not be able to add files to the web 
space, and editing existing files may corrupt them. 

8 To complete the setup, click OK.  

It may take up to 48 hours for the information on new subdomain to spread in the 
Domain Name System and become available to the Internet users.  

To publish web content to the subdomainôs web space, follow the instruction presented 
in the Publishing Your Site (on page 27) section. 
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Removing Subdomains 

ü To remove a subdomain with its web content: 

1 On your Home page, click Subdomains. 

2 Select a check box corresponding to the subdomain name that you 
wish to remove.   

3 Click   Remove Selected. Confirm removal and click OK. 

The subdomain configuration and its web content will be removed from the server. 
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Setting Up Anonymous FTP Access to the 
Server 

If you host your site on a dedicated IP address, you can set up a directory within the 
site, where other users will be able to anonymously download or upload files through 
FTP. Once anonymous FTP is enabled, the users will be able to log in to the 
ftp://ftp.your-domain.com with the "anonymous" login name and any password. 

To allow anonymous FTP access: 

1 Click the Anonymous FTP icon in the Hosting group. 

2 To activate anonymous FTP service, click the Switch On icon. 

3 To set up a welcoming message to be displayed when users log in to 
FTP site, select the Display login message check box and type the 
message text in the input field as desired.  

Note that not all FTP clients display welcoming messages. 

4 To allow visitors to upload files to the /incoming directory, select the 
Allow uploading to incoming directory check box. 

5 To allow users to create subdirectories in the /incoming directory, 
select the Allow creation of directories in the incoming directory check box. 

6 To allow downloading files from the /incoming directory, select the 
Allow downloading from the incoming directory checkbox. 

7 To limit the amount of disk space that can be occupied by uploaded 
files, deselect the Unlimited check box corresponding to the Limit disk 
space in the incoming directory option, and specify the amount in kilobytes.  

This is the hard quota: the users will not be able to add more files to the directory 
when the limit is reached. 

8 To limit the number of simultaneous connections to the anonymous 
FTP server, deselect the Unlimited check box corresponding to the  Limit 
number of simultaneous connections option and specify the number of 
allowed connections. 

9 To limit the bandwidth for anonymous FTP connections, deselect the 
Unlimited check box corresponding to the  Limit download bandwidth for this 
virtual FTP domain option and enter the maximum bandwidth in kilobytes 
per second. 

10 Click OK. 

 

To modify settings for anonymous FTP server or switch it off: 

1 On your Home page, click the domain name you need. 

2 Click the Anonymous FTP icon in the Hosting group. 

ftp://ftp.your-domain.com/
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3 Adjust the settings as required and click OK.or click the Switch Off icon 
in the Tools group to switch off the anonymous FTP service. 

 
 

Setting Up Additional Domain Names for a 
Site (Domain Aliases) 

If you have registered with a domain name registrar several domain names that you 
would like to point to the same web site that you host on this server, you should set up 
domain aliases, as described in this chapter. 

In this section: 

Setting Up a Domain Alias ................................................................................. 62 
Modifying Properties of a Domain Alias ............................................................. 63 
Removing a Domain Alias ................................................................................. 63 
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Setting Up a Domain Alias 

ü To set up a domain alias: 

1 Go to Domain Aliases and click Add Domain Alias. 

2 Type the desired domain alias name, for example alias.com.  

Domain aliases can comprise letters, digits and hyphens. Each part of the domain 
alias between dots should not be longer than 63 symbols. 

3 Select the Synchronize DNS zone with the primary domain check box if you 
want the domain alias to use the same DNS zone resource records as 
in primary domain. With this setting, any subsequent changes in 
resource records of the primary domain's zone will be applied to the 
DNS zone of this domain alias.    

4 Select the Mail check box, if you want e-mail directed at the e-mail 
addresses under the domain alias to be redirected to the e-mail 
addresses under your original domain name. 

Example: You have an e-mail address mail@yourdomain.com. You have set up an 
alias for your domain name, for example, alias.com. If you want to receive mail to 
your mailbox mail@yourdomain.com when it is sent to mail@alias.com, select the 
Mail check box. 

5 Select the Web check box. Otherwise, the web server will not serve the 
web content to users coming to your site by typing the domain alias in 
their browsers. 

6 Select the Java Web applications check box if you have Java applications 
installed on your site and you want them to be accessible through the 
domain alias. 

7 Click OK. 

 
 

mailto:mail@yourdomain.com
mailto:mail@yourdomain.com
mailto:mail@alias.com
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Modifying Properties of a Domain Alias 

ü To change the properties of an alias:  

1 Go to Domain Aliases and click the alias name you need. 

2 Change the properties and click OK. 

 

ü To modify resource records in the DNS zone of a domain alias: 

1 Go to Domain Aliases and click the alias name you need. 

2 Click DNS Settings. 

3 Add, edit or remove the resource records as required: 

Á To add a resource record to the zone, click Add New Record. Specify the required 
values and click OK to write the values to the zone. 

Á To modify a resource record, under the Host column, click a hyperlink 
corresponding to the record you need. 

Á To remove a record, select a check box corresponding to the record you wish to 

remove and click  Remove Selected. 

To learn more about DNS resource records modification and other DNS-related 
options, refer to the Customizing DNS Zone Configuration for Your Domain (on page 
47) and the Serving Your Site with External Domain Name Servers (on page 53) 
sections. 

Removing a Domain Alias 

ü To remove an alias from a domain:  

1 Click Domain Aliases on your home page. 

2 Select a check box corresponding to the domain alias that you want to 
remove. 

3 Click  Remove Selected. Confirm removal and click OK. 
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Hosting Personal Web Pages on Your 
Web Server 

You can host on your Web server personal Web pages for individuals who do not need 
their own domain names. This service is popular with educational institutions that host 
non-commercial personal pages of their students and staff. 

These pages usually have Web addresses like http://your-domain.com/~username. 

ü To accommodate a personal Web page on your server, allocate a separate Web space 
and set up an FTP account for publishing: 

1 On your Home page, click Web Users. 

2 Click Preferences. 

3 If you wish to allow execution of scripts embedded in personal web 
pages, select the Allow the web users scripting check box. 

4 Click OK.  

The settings you have defined at the step 3 are common for all personal Web 
pages you might host on your Web server. Therefore, you will not need to perform 
steps 2 to 4 next time you set up a Web space for a personal Web page. 

5 Click Add New Web User. 

6 Specify a user name and password that will  be used for accessing the 
Web space through FTP and publishing the Web page.  

You can use only lowercase alphanumeric, hyphen and underscore symbols in user 
name. The user name should begin with an alphabet character. It cannot contain 
white spaces. The password cannot contain quotation marks, white space, user's 
login name, and should be between 5 and 14 characters in length.   

7 Specify the programming languages that should be supported for the 
Web page.  

For example, if the Web page is written in PHP, select the PHP support check box. 

8 If you wish to limit the amount of disk space that can be occupied by 
the Web page content, clear the Unlimited checkbox and type the 
desired value in megabytes into the Hard disk quota box.  

When the specified limit is exceeded, the Web page owner will not be able to add 
files to his or her Web space. 

9  Click OK. 

Now you can tell your user the FTP account credentials, so that he or she can publish 
their Web page. 

http://your-domain.com/~username
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In this section: 

Changing FTP Password for a Web Page Owner .............................................. 65 
Allocating More Disk Space to the Web Page Owner ........................................ 65 
Removing Web Page Owner's Account ............................................................. 65 
 
 

Changing FTP Password for a Web Page Owner 

ü To change FTP password for a web page owner: 

1 Go to Web Users > user name. 

2 Type the new password into the New password and Confirm password 
boxes. 

3 Click OK. 

 
 

Allocating More Disk Space to the Web Page Owner 

ü To allocate more disk space to the web page owner: 

1 Go to Web Users > user name. 

2 Type the amount of disk space in megabytes into the Hard disk quota 
box. 

3 Click OK. 

 
 

Removing Web Page Owner's Account 

ü To remove a web page ownerôs account together with his or her web page: 

1 On your Home page, click Web Users. 

2 Select a check box to the right of the user name you wish to remove.  

3 Click  Remove Selected. Confirm removal and click OK. 

 

 



 

  
 

You can use a number of different e-mail services with a single e-mail account. For 
example, you can have an e-mail address that will accept mail as any standard 
mailbox, forward to a number of recipients, and send an automatic response to the 
original message sender. 

In this chapter: 

Creating Mailboxes............................................................................................ 67 
Setting Up Your E-mail Program for Retrieving Mail From Your Mailbox ........... 69 
Accessing Your Mail From a Web Browser........................................................ 70 
Protecting Mailboxes From Spam ...................................................................... 71 
Protecting Mailboxes From Viruses ................................................................... 76 
Suspending and Unsuspending Mailboxes ........................................................ 77 
Removing Mailboxes ......................................................................................... 78 
Switching off the Mailbox Service When You Have Decided to Turn Your Account 
into a Mail Forwarder ......................................................................................... 78 
Setting Up Mail Forwarding to a Single E-mail Address ..................................... 79 
Setting Up Mail Forwarding to Multiple E-mail Addresses.................................. 81 
Removing Mail Forwarders ................................................................................ 83 
Setting Up Automatic Reply ............................................................................... 84 
Switching off Automatic Reply ........................................................................... 86 
Setting Up Site-wide Preferences for Handling Mail to Nonexistent Users ......... 86 
Introducing Changes to a Number of Mail Accounts at Once ............................. 87 
Maintaining Mailing Lists ................................................................................... 87 
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Creating Mailboxes 

If you wish to have an e-mail address associated with your site, like yourname@your-
domain.com, you should create a mailbox. To do this: 

1 Go to Mail and click Add New Mail Account. 

2 Your domain name is shown to the right of @ sign, so you only need 
to specify the desired name for the mailbox.  

This can be, for example, your first name and last name separated by a dot, a 
department name, or any other text in Latin symbols. The name should be short 
enough to remember. It can comprise alphanumeric, dash, dot and underscore 
symbols. 

3 Specify a password that you will use for accessing your mailbox.  

4 Make sure that a check mark is present in the Mailbox check box. 

5 Click OK. 

Now your mailbox is created on the providerôs server, and you can set up your favorite 
e-mail program so as to receive and send e-mail messages through your new mailbox. 

ü To create mailboxes for other users: 

1 Go to Mail and click Add New Mail Account. 

2 Your domain name is shown to the right of @ sign, so you only need 
to specify the desired name for the mailbox.  

This can be, for example, userôs first name and last name separated by a dot, a 
department name, or any other text in Latin symbols. The name should be short 
enough to remember. It can comprise alphanumeric, dash dot and underscore 
symbols. 

3 Specify a password that mailbox owner will use for accessing his or 
her mailbox. 

4 Make sure that a check mark is present in the Mailbox check box. 

5 If required, limit the amount of disk space that this mailbox and it's 
autoresponder attachment files can use. To do this, under Mailbox quota 
select the Enter size option and type the desired value in kilobytes. 

6 To allow the mailbox owner to manage his or her mailbox through a 
mailbox administration panel, select the Control panel access check box 
and specify the language for the userôs control panel.   

7 Click OK. 

8 To allow the mailbox owner configure and use spam filter and 
antivirus, click Permissions, select the respective check boxes and click 
OK. 

 

mailto:yourname@your-domain.com
mailto:yourname@your-domain.com
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Now, the mailbox is created, and a separate e-mail administration panel has been set 
up in Plesk. To enter it, the mailbox owner should visit the URL https://your-
domain.com:8443, type his or her e-mail address into the Login box, type the password 
for the mailbox into the Password box, and then click Login. 
 

https://your-domain.com:8443/
https://your-domain.com:8443/
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Setting Up Your E-mail Program for 
Retrieving Mail From Your Mailbox 

ü To set up Microsoft Outlook Express: 

1 Open Microsoft Outlook Express. 

2 Go to Tools > Accounts. 

3 Click the Mail tab to open a list of your mail accounts. 

4 Click the Add > button and select the Mail é item. 

5 Enter your name as you want it to appear in any messages you send, 
and click Next >. 

6 Type your e-mail address that you created through Plesk (for 
example, your.name@your-domain.com), and click Next >. 

7 Select the protocol of your incoming mail server.  

8 Specify the mail domain name as the incoming and outgoing mail 
server (for example: mail.your-domain.com), and click Next >. 

9 Type your e-mail address in the Account name box (for example: 
your.name@your-domain.com). 

10 Type your password. This should be the password that you specified 
during creation of the mailbox through Plesk.  

11 Leave the Remember password box checked, if you do not wish to be 
prompted to enter password each time your e-mail program connects 
to the mail server to check for new mail, and click Next >. 

12 To complete setting up your e-mail program, click Finish. 

 

ü To set up Mozilla Thunderbird: 

1 Open Mozilla Thunderbird. 

2 Go to Tools > Account Settingsé 

3 Click Add Account. The Account Wizard will open. 

4 Leave the Email account option selected, and click Next >. 

5 Enter your name as you want it to appear in any messages you send. 

6 Type your e-mail address that you created through Plesk.  

For example, your.name@your-domain.com. Click Next >. 

7 Select the protocol of your incoming mail server.  

8 Specify the mail domain name as the incoming and outgoing mail 
server (for example: mail.your-domain.com), and click Next >. 

9 In the Incoming User Name box, specify your full e-mail address (for 
example, your.name@your-domain.com), and click Next >. 

mailto:your.name@your-domain.com
mailto:your.name@your-domain.com
mailto:your.name@your-domain.com
mailto:your.name@your-domain.com
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10 Enter the name by which you would like to refer to this account (for 
example, Work Account) and click Next >. 

11 Verify that the information you entered is correct, and click Finish. 

12 Click OK to close the Account Settings wizard. 
 

Accessing Your Mail From a Web Browser 

You can read your mail and compose new messages even if you are far from your 
home or office computer. To do this, you first need to allow access to the Horde 
Webmail interface that is integrated with your control panel. Then you can work with 
your mail from any computer with Internet connection and Web browser installed, or a 
WAP-enabled cellular phone or a handheld computer (PDA). 

ü To allow access to the Webmail interface: 

1 On your Home page, click the Mail icon. 

2 Click Preferences. 

3 Select the WebMail check box. 

4 Click OK. 

 

Note: Activation and deactivation of Webmail for your domain involves modifications in 
DNS zone, therefore, there is actually a certain delay present when activating and 
deactivating Webmail due to the speed of DNS registration mechanisms. 

ü To access your mailbox through Webmail: 

1 Open a Web browser (or a WAP browser, if you are working from a 
handheld device), and type the URL: http://webmail.your-domain.com, 
where your-domain.com is the name of your domain. Press ENTER. 
The webmail login screen will open. 

2 Type the user name and password that you specified during creation 
of your mailbox and click Log in. 

 
 

http://webmail.your-domain.com/
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Protecting Mailboxes From Spam 

To protect your mailbox from undesirable correspondence, do not publish your e-mail 
address on Internet forums and switch on the server-side spam filter provided by the 
SpamAssassin software. 

When you need to publish your e-mail address, create a disposable e-mail address - e-
mail alias - for your primary e-mail address, and publish it instead. All messages sent to 
the e-mail alias will come into your mailbox. Once you start getting spam, remove that 
alias and create another one. If you have a mailbox at another domain or mail server, 
you may want to set up a disposable e-mail forwarder. 

We would advise that you do not read spam e-mails when you receive them, just delete 
them at once. Even if you have read them, do not respond to them and do not click the 
ñclick here to unsubscribeò URLs: spammers will then know that your e-mail address is 
valid and you will get even more spam. 

In this section: 

Setting Up Additional Disposable E-mail Addresses for Your Mailbox (E-mail Aliases)
 .......................................................................................................................... 71 
Setting Up Spam Filter ...................................................................................... 72 
 
 

Setting Up Additional Disposable E-mail Addresses for 
Your Mailbox (E-mail Aliases) 

ü To set up an e-mail alias for a mailbox: 

1 Go to Mail > e-mail address and click Add New Mail Alias. 

2 Type a desired name and click OK. 

The messages addressed to your additional e-mail address (e-mail alias) will get to 

your mailbox. You can see the list of currently used mail aliases by clicking  Show 
Aliases in the list of mail accounts under the domain. 

ü To remove an e-mail alias from a mailbox: 

1 Go to Mail > e-mail address. 

2 Select the check box corresponding to the alias that you wish to 

remove, and click  Remove Selected. Confirm the removal and click OK. 
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Setting Up Spam Filter 

If you receive undesirable correspondence to an e-mail address that you cannot or do 
not want to remove, consider setting up spam filter for your mailbox. To do this, 

Á Enable SpamAssassin spam filter on your hosting account, if supported by your 
provider, and 

Á Install spam filtering software of your choice to work with e-mail program on your 
home or office computer. 

In this section: 

Switching On Spam Filter ..................................................................................73 
Improving Accuracy of Spam Detection .............................................................75 
Clearing Spam Filter's Database ........................................................................75 
Switching Off Spam Filter ..................................................................................76 
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Switching On Spam Filter 

To switch on spam filtering for a mailbox: 

1 On your Home page, click the Mail icon in the Services group. 

2 Click the e-mail address you need. 

3 Click the Spam Filter icon in the Tools group. 

4 Configure the following settings as desired: 

Á The score required before a mail is considered spam. This setting adjusts spam filter 
sensitivity. SpamAssassin performs a number of different tests on contents and 
subject line of each message. As a result, each message scores a number of 
points. The higher the number, the more likely a message is spam. For 
example, a message containing the text string ñBUY VIAGRA AT LOW 
PRICE!!!ò in Subject line and message body scores 8.3 points. By default, the 
filter sensitivity is set so that all messages that score 7 or more points are 
classified as spam. 

If you receive lots of spam messages with the current setting, to make filter 
more sensitive, try setting a lesser value in the The score required before a mail is 
considered spam box; for example, 6.  

If you are missing your e-mails because your spam filter thinks they are junk, try 
reducing filter sensitivity by setting a higher value in the The score required before a 
mail is considered spam box. 

Note: To further improve spam filter accuracy, you may want to train your spam 

filter on e-mail messages you receive (see the instructions on improving 
accuracy of spam detection in the following section).  

Á What to do with spam mail. If you are sure that your spam filter is accurate, you 
may want to set the filter to automatically delete all incoming messages 
recognized as spam. To do this, select the Delete option. If you wish to filter mail 
with the software on your local computer, select the Mark as spam and store in 
mailbox option, and then specify how spam filter should mark the messages 
recognized as spam. ñX-Spam-Flag: YESò and ñX-Spam-Status: Yesò headers 
are added to the message source by default, and if you want, the spam filter will 
also include a specific text string to the beginning of Subject line. To include a 
desired combination of symbols or words to the message subject, type it into the 
Add the following text to the beginning of subject of each message recognized as spam 
box. If you do not want the spam filter to modify message subject, leave this box 
blank. If you want to include into the subject line the number of points that 
messages score, type _SCORE_ in this box. 

5 If you do not want to receive e-mail from specific domains or 
individual senders, click the Black List tab, and then add the respective 
entries to the spam filterôs black list: 
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Á To add entries to the black list, click Add Addresses. If you have a list of entries 
stored in a file, click Browse to specify it, and then click OK. Otherwise, select the 
From List option, and type the e-mail addresses into the E-mail addresses box. 
Place each address in one row, or separate addresses with a coma, a colon, or 
a white space. You can use an asterisk (*) as a substitute for a number of 
letters, and question mark (?) as a substitute for a single letter. For example: 
address@spammers.net, user?@spammers.net, *@spammers.net. Specifying 
*@spammers.net will block the entire mail domain spammers.net. To save the 
entries you added, click OK, then confirm adding, and click OK again. 

Á To remove entries from the black list, under the Black List tab, select the entries 
and click Remove Selected. Confirm removal and click OK.  

6 If you want to be sure that you will not miss e-mail from specific 
senders, click the White List tab, and then add e-mail addresses or 
entire domains to the spam filterôs white list: 

Á To add entries to the white list, click Add Addresses. If you have a list of entries 
stored in a file, click Browse to specify it, and then click OK. Otherwise, select the 
From List option, and type the e-mail addresses into the E-mail addresses box. 
Place each address in one row, or separate addresses with a coma, a colon, or 
a white space. You can use an asterisk (*) as a substitute for a number of 
letters, and question mark (?) as a substitute for a single letter. For example: 
address@mycompany.com, user?@mycompany.com, *@mycompany.com. 
Specifying *@mycompany.com will add to the white list all e-mail addresses that 
are under the mycompany.com mail domain. To save the entries you added, 
click OK, then confirm adding, and click OK again. 

Á To remove entries from the white list, under the White List tab, select the entries 
and click Remove Selected. Confirm removal and click OK. 

7 Once finished with setting up the spam filter, click the Switch On Spam 
Filtering  icon, and then click OK. 
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Improving Accuracy of Spam Detection 

You can improve accuracy of spam detection by training the spam filter on the e-mail 
messages that you have in your mailbox.  

To improve accuracy of spam detection: 

1 On your Home page, click the Mail icon in the Services group. 

2 Click the e-mail address you need. 

3 Click the Spam Filter icon in the Tools group. 

4 Click the Training tab.  

All e-mail messages you have in your mailbox are presented on the screen. Each 
message is accompanied by an icon in the left column, which tells if a message is 

recognized as spam - , non-spam - , or not recognized at all - . If you have 
already trained your spam filter on a message and the results were recorded in the 

spam filterôs database, an icon  is shown in the right column. 

5 Train the spam filter.  

In most cases, you can tell if a message is spam by looking at its subject line and 
senderôs name. If they do not give you any clue, try looking inside the message 
using your e-mail program or Webmail interface. 

Á To mark a message as spam, select the corresponding check box and click ôItõs 
Spam!õ. 

Á To mark a message as not spam, select the corresponding check box and click 
ôItõs Not Spamõ. 

Á To remove any information on a given message from the spam filter database, 
select the corresponding check box and click ôForget Itõ. 

6 Once finished with training, you can remove spam e-mails from your 
mailbox using your e-mail program or Horde IMP Webmail interface. 

 
 

Clearing Spam Filter's Database 

If you have accidentally made your spam filter learn a great number of spam e-mails as 
non-spam or vice versa, your spam filter will likely produce incorrect results. In this 
case, clear the spam filter's database and then repeat training. 

To clear spam filterôs database: 

1 On your Home page, click the Mail icon in the Services group. 

2 Click the e-mail address you need. 

3 Click the Spam Filter icon in the Tools group. 

4 Click the Training tab. 

5 Click the Clear button. 
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Switching Off Spam Filter 

To switch off spam filtering for a mailbox: 

1 On your Home page, click the Mail icon in the Services group. 

2 Click the e-mail address you need. 

3 Click the Spam Filter icon in the Tools group. 

4 Click the Switch Off Spam Filtering icon and then click OK. 

 
 

Protecting Mailboxes From Viruses 

To defend your system from viruses, do not open suspicious e-mail attachments, 
enable anti-virus protection on the server side, if this service is provided by your 
hosting company, and be sure to have a firewall and anti-virus software installed on 
your personal computer. Also keep your operating system up-to-date and timely install 
security hotfixes and patches. 

In this section: 

Switching On Anti-virus Protection .................................................................... 76 
Switching Off Anti-virus Protection .................................................................... 77 
 
 

Switching On Anti-virus Protection 

ü To switch on anti-virus protection for a mailbox: 

1 On your Home page, click the Mail icon. 

2 Click the e-mail address you need. 

3 Click the Antivirus icon in the Tools group. 

4 Choose the desired mail scanning mode. You can switch on scanning 
for incoming mail, outgoing mail, or both. 

Note: If Kaspersky Antivirus is used on the server, then you can use the Scanning 
settings icon to adjust scanning settings. To view the information about scanning 
settings, click the Help shortcut in the navigation pane. 

5 Click OK. 
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Switching Off Anti-virus Protection 

ü To switch off anti-virus protection for a mailbox: 

1 On your Home page, click the Mail icon. 

2 Click the e-mail address you need. 

3 Click the Antivirus icon in the Tools group. 

4 Select the Do not scan for viruses option and click OK. 

 
 

Suspending and Unsuspending Mailboxes 

ü To temporarily suspend e-mail services for a mailbox: 

1 Go to Mail > e-mail address > Mailbox. 

2 Clear the Mailbox check box. 

3 Click OK. 

 

ü To resume e-mail services for a suspended mailbox: 

1 Go to Mail > e-mail address > Mailbox. 

2 Select the Mailbox check box. 

3 Click OK. 

 

ü To temporarily suspend e-mail services for all mailboxes in your domain: 

1 On your Home page, click Mail. 

2 Click Switch Off in the Tools group. 

 

ü To resume e-mail services for all mailboxes in your domain: 

1 On your Home page, click Mail. 

2 Click Switch On in the Tools group. 
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Removing Mailboxes 

ü To remove a mailbox: 

1 On your Home page, click Mail. 

2 Select a check box corresponding to the mailbox that you wish to 
remove. 

3 Click  Remove Selected. Confirm removal and click OK. 

 
 

Switching off the Mailbox Service When 
You Have Decided to Turn Your Account 
into a Mail Forwarder 

If you are going to use your existing e-mail account as a mail forwarder or mailing list, 
you are recommended to switch off the mailbox service: a mailbox keeps all incoming 
messages and messages are not removed automatically after being forwarded. 
Therefore, if you choose to have the "mailbox + mail forwarder" configuration on your 
account, be sure to clean up the mailbox from time to time. 

ü To switch off the mailbox service for your account discarding all messages in your 
mailbox: 

1 Go to Mail > e-mail address > Mailbox. 

2 Deselect the Mailbox check box. 

3 Click OK. 
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Setting Up Mail Forwarding to a Single E-
mail Address 

ü To set up an e-mail address that will accept mail and forward it to another e-mail 
address: 

1 Go to Mail and click Add New Mail Account. 

2 Specify the desired name for the mail forwarder next to Mail account 
name. 

The domain name is shown to the right of @ sign, so you only need to type the 
name. This can be, for example, your first name and last name separated by a dot, 
a department name, or any other text in Latin symbols. The name should be short 
enough to remember. It can comprise alphanumeric, dash dot and underscore 
symbols. 

3 Clear the Mailbox check box and click OK. 

4 Click Redirect in the Tools group. 

5 Select the Redirect check box. 

6 Type the destination e-mail address to which you would like to 
forward e-mail. 

7 Click OK.  

 

ü To set up an e-mail address that will accept mail, pass it through the spam filter and 
then forward it to another e-mail address:  

1 Go to Mail and click Add New Mail Account. 

2 Specify the desired name for the forwarderôs e-mail address next to 
Mail account name. 

The domain name is shown to the right of @ sign, so you only need to type the 
name. This can be, for example, your first name and last name separated by a dot, 
a department name, or any other text in Latin symbols. The name should be short 
enough to remember. It can comprise alphanumeric, dash dot and underscore 
symbols. 

3 Make sure that the Mailbox check box is selected.  

Without a mailbox, you will not be able to apply spam filtering. 

4 Specify a password that will be used for accessing the mailbox. You 
will likely need to clean the contents of mailbox from time to time. 
Click OK. 

5 Configure the spam filter as described in the Setting Up Spam Filter 
(on page 72) section. 

6 Click Redirect in the Tools group. 

7 Select the Redirect check box. 
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8 Type the destination e-mail address to which you would like to 
forward e-mail. 

9 Click OK. 

In this section: 

Suspending and Unsuspending Mail Forwarders ...............................................80 
 
 

Suspending and Unsuspending Mail Forwarders 

ü To suspend a mail forwarder: 

1 Go to Mail > e-mail address > Redirect. 

2 Clear the Redirect check box. 

3 Click OK. 

 

ü To unsuspend a mail forwarder: 

1 Go to Mail > e-mail address > Redirect. 

2 Select the Redirect check box. 

3 Click OK. 
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Setting Up Mail Forwarding to Multiple E-
mail Addresses 

ü To set up an e-mail address that will accept mail and forward it to multiple other e-mail 
addresses: 

1 Go to Mail and click Add New Mail Account. 

2 Specify the desired name for the mail forwarder next to Mail account 
name. 

The domain name is shown to the right of @ sign, so you only need to type the 
name. This can be, for example, your first name and last name separated by a dot, 
a department name, or any other text in Latin symbols. The name should be short 
enough to remember. It can comprise alphanumeric, dash dot and underscore 
symbols. 

3 Clear the Mailbox check box and click OK. 

4 Go to Mail Group and click Add New Member. 

You should add at least one e-mail address before enabling mail forwarding to 
several e-mail addresses. 

5 Enter the desired external e-mail address into the E-mail input field 
and/or select one or more of the listed mail accounts using check 
boxes. 

6 Click OK, then click Switch On. 

 

In this section: 

Adding and Removing Recipient Addresses ...................................................... 82 
Switching off Mail Forwarding to Multiple E-mail Addresses .............................. 83 
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Adding and Removing Recipient Addresses 

ü To add an external e-mail address to the list of mail accounts that receive forwarded e-
mail correspondence: 

1 Go to Mail > e-mail address > Mail Group and click Add New Member. 

2 Enter the desired external e-mail address into the E-mail input field. 

3 Click OK. 

 

ü To remove an external e-mail address from the list of mail accounts that receive 
forwarded e-mail correspondence: 

1 Go to Mail > e-mail address > Mail Group. 

2 Select the check box corresponding to the mail account you wish to 
remove from the list. 

3 Click  Remove Selected. Confirm removal and click OK. 

 

ü To add an e-mail address registered on your server to the list of mail accounts that 
receive forwarded e-mail correspondence: 

1 Go to Mail > e-mail address > Groups. 

2 Select the required multiple e-mail forwarder in the Available mail groups 
list. 

3 Click Add >>. 

4 Click OK. 

An e-mail address registered on your server can also be added to the subscription list 
using the procedure for adding an external e-mail address (see above). 

ü To remove an e-mail address registered on your server from the list of mail accounts 
that receive forwarded e-mail correspondence: 

1 Go to Mail > e-mail address > Groups. 

2 Select the required multiple e-mail forwarder in the Member of the 
following mail groups list. 

3 Click << Remove. 

4 Click OK. 

An e-mail address registered on your server can also be removed from the subscription 
list using the procedure for removing an external e-mail address (see above). 
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Switching off Mail Forwarding to Multiple E-mail 
Addresses 

ü To disable the e-mail forwarding to several e-mail addresses: 

1 Go to Mail > e-mail address > Mail Group. 

2 Click Switch Off. 
 

Removing Mail Forwarders 

ü To remove a mail forwarder: 

1 On your Home page, click Mail. 

2 Select a check box corresponding to the mail forwarder that you wish 
to remove. 

3 Click  Remove Selected. Confirm removal and click OK. 
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Setting Up Automatic Reply 

If you are going on vacation and will not be able to check your mail for a while, you may 
want to leave a vacation notice that will be automatically sent to your correspondents 
once they send e-mail to your address. This is done with automatic reply facility, also 
referred to as autoresponder. Aside from vacation notices, organizations can use 
automatic replies to notify customers that their orders or technical support requests 
were received and will soon be processed. Automatic replies can include prewritten 
messages in plain text or HTML format, and they can contain attached files as well. 

ü To set up automatic reply for a mailbox: 

1 On your Home page, click the Mail icon. 

2 Click the e-mail address, for which you wish to set up an automatic 
reply. 

3 Click the Autoresponders icon in the Tools group. 

4 If you are not going to attach any files to the automatic reply, proceed 
to the step 5. To attach a file to the automatic reply:  

1. Click the Attachment Files icon in the Tools group.  

2. Click Browse to locate the file, and once selected, click Send File.  

The file will be added to the attachment files storage, and you will be able to 
attach this file to a number of different automatic replies.  

3. Once finished, click  Up Level and proceed to the next step. 

5 Click the Add New Autoresponder icon in the Tools group. 

6 Configure the automatic reply: 

1. Type a name for this automatic reply into the Autoresponder name 
box.  

For example, 'Vacation notice'. 

2. If you want your incoming mail to be forwarded to another e-
mail address while you are away, specify an e-mail address in 
the Upon automatic response, forward the original message to the specified 
e-mail box. 

3. If you want this automatic reply to be sent in reply to any 
incoming e-mail message, in the Conditions group, leave the 
always respond option selected. If you wish to automatically reply 

only to e-mail messages that contain specific words in the 
message text or subject line, select the appropriate option, 
and type the word combination in the input box. 

4. By default, the subject line of incoming e-mail will be inserted 
into the automated reply. To use a custom subject, type it into 
the Reply subject input box. 



 

 Using E-mail Services 85 

 

5. As your correspondents may not figure out that the message 
they received from you was an automatic response, they may 
want to respond to your auto-reply. So, you should specify 
your e-mail address as the Return address, otherwise, their 
messages will be directed at the autoresponderôs address. 

6. Specify the automatic reply message format (plain text or HTML) 
and character encoding (UTF-8 is recommended). If you use 
HTML tags in your auto-reply message, you should select the 
HTML option. 

7. Type your message in the Reply with text field. 

8. Attach your files, if needed. To do this, click the  Add New 
Attachment button, select the check box corresponding to the 

file that you previously uploaded to the attachment storage, 
and click OK. To remove an attached file from the automatic 

reply, select the corresponding checkbox, and click  Remove 
Selected. 

9. To limit the number of automated responses per day to the 
same e-mail address, enter the desired number in the 
respective input box under Limits.  

The default setting is to respond no more than ten times in one day to the same 
e-mail address. 

10. To reduce mail server load, you may want to limit the 
number of unique addresses that the autoresponder will 
remember. To do this, enter the desired number into the Store 
up to box. 

7 Click OK. 

8 Click the Switch On icon in the Tools group. 
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Switching off Automatic Reply 

ü To switch off an automatic reply for a mailbox: 

1 Go to Mail > e-mail address > Autoresponders. 

2 Click Switch Off. 

The automatic reply is now switched off. Its configuration is not deleted from the control 
panel, so the next time you need to use this automatic reply, repeat the above 
procedure, clicking Switch On on the last step. 

ü To delete an automatic reply configuration that you no longer need: 

1 Go to Mail > e-mail address > Autoresponders. 

2 Select a check box corresponding to the configuration name, and click 

 Remove Selected. Confirm the removal and click OK. 

 
 

Setting Up Site-wide Preferences for 
Handling Mail to Nonexistent Users 

When somebody sends an e-mail message to an e-mail address that does not exist 
under your domain, the mail server, by default accepts mail, processes it, and when it 
finds out that there is no such a recipient under the domain, it returns the mail back to 
sender with the ñthis address no longer accepts mailò notice. You can choose to: 

Á Change the default notice if you do not like it, 

Á Forward all such mail to the desired e-mail address,  

Á Reject such mail without accepting it and without notifying senders.  

This setting can decrease mail server load caused by a large amount of spam, 
which is often sent to randomly generated user names. However, for spammers, 
this can somewhat speed up scanning your mail server for valid e-mail addresses. 

ü To configure the site-wide settings for serving mail to nonexistent users:  

1 Go to Mail > Preferences. 

2 Choose a desired option and specify the information as required.  

3 Click OK. 
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Introducing Changes to a Number of Mail 
Accounts at Once 

ü To introduce similar changes to a number of mail accounts at once: 

1 Click Mail in the Services group. 

2 Select the check boxes corresponding to the mail accounts whose 
settings you want to modify. 

3 Click  Group Operations. 

4 Adjust the settings as necessary: 

Á Select Switch on to enable the corresponding option for the selected mail 
accounts. 

Á Select Switch off to disable the corresponding option for the selected mail 
accounts. 

Á Leave Do not change selected if you do not want to change the corresponding 
option. 

5 Click OK. 

 
 

Maintaining Mailing Lists 

If you wish to deliver offers and promotions to your customers, run a newsletter, or 
inform visitors of your site of recent updates, you should set up a mailing list on your 
site and subscribe your users to it or invite them to subscribe themselves. 

Mailing list is a convenient way to reach a number of readers at once: it contains a list 
of subscribersô e-mail addresses, which are combined under a single e-mail address, to 
which you post your information or a newsletter. Mailing lists are provided by the GNU 
Mailman software, which may or may not be installed on your server.  

To make sure that you can use mailing lists, contact your provider or look it up in the 
control panel: go to Home > Mail, click the Mailing lists tab, and see if there is an Add New 
Mailing list icon displayed in color. 

In this section: 

Setting Up a Mailing List .................................................................................... 88 
Configuring Mailing List ..................................................................................... 89 
Subscribing and Unsubscribing Users ............................................................... 89 
Posting to Your Mailing List ............................................................................... 90 
Removing Mailing Lists ..................................................................................... 90 
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Setting Up a Mailing List 

ü To set up a mailing list: 

1 On your Home page, click the Mail icon in the Services group. 

2 Click the Mailing lists tab. 

3 Click the Switch On icon in the Tools group to start up the Mailman 
software on the server. 

4 Click the Add New Mailing List icon in the Tools group. 

5 Specify the desired name for the mailing list.  

This can be, for example, a department name, a topic of the mailing list, or any 
other text in Latin symbols. The name should be short enough to remember. It can 
comprise alphanumeric, dash, dot and underscore symbols. 

6 Specify the password that will be used for administering the mailing 
list. 

7 Specify the mailing list administratorôs e-mail. 

8 Leave the Notify administrator of the mailing list creation check box selected. 

You will receive instructions on using and managing the mailing list at the 
administratorôs e-mail you specified. Keep that message for your records. 

9 Click OK. 
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Configuring Mailing List 

Your mailing list is operable with the default settings. However, you may want to 
configure it, for example, so as to enable moderation, filter content of the posts or to 
archive messages. To do this from the control panel: 

1 On your Home page, click the Mail icon in the Services group. 

2 Click the Mailing lists tab. 

3 Click the  icon next to the desired mailing listôs e-mail address.  

A login screen opens. 

4 Type the list administratorôs password and click Let me in é. 

 

Alternately, you can access the mailing list configuration the following way: 

1 In your web browser, enter the following URL: http://lists.<your-
domain.com>/mailman/admin/<listname> (where <your-domain.com> 
is your domain name, and <listname> is the name of the mailing list 
(i.e. the left part of the mailing listôs e-mail address before the @ 
sign).  

A login screen opens.  

2 Type the list administratorôs password and click Let me in é. 

 
 

Subscribing and Unsubscribing Users 

ü To subscribe users to mailing list: 

1 Go to Mail > Mailing lists tab > mailing list name and click Add New Member. 

2 Specify subscriberôs e-mail address. 

3 Click OK. 

 

ü To unsubscribe users from mailing list:  

1 Go to Mail > Mailing lists tab > mailing list name. 

2 Select a check box to the left of the userôs e-mail address. 

3 Click  Remove Selected. Confirm removal and click OK. 
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Posting to Your Mailing List 

To post a newsletter issue or other information to the mailing list, send it by e-mail to 
the mailing listôs e-mail address. All subscribed users will receive it. 

Removing Mailing Lists 

ü To remove a mailing list from site: 

1 Go to Mail > Mailing lists tab. 

2 Select a check box corresponding to the mailing list that you wish to 
remove. 

3 Click  Remove Selected. Confirm removal and click OK. 

 

 



 

  
 

ü To choose the statistical program you want (Webalizer or AWStats): 

1 On your Home page, click Setup. 

2 Select the statistical package you need from the Web statistics menu 
(AWStats is recommended), and select the accessible via password protected 
directory /plesk-stat/ check box.  

This will install the statistical software of your choice, which will generate reports 
and place them into the password protected directory. You will then be able to 
access Web statistics at the URL: https://your-domain.com/plesk-stat/webstat using 
your FTP account login and password. 

3 Click OK. 

Note: When you switch from one statistical program to another, all reports generated 
by the previously used statistical program are removed from the server.   

To find out the amount of bandwidth and disk space used by your site, see the Disk 
Space and Traffic rows in the table at the bottom of your Home page. 

ü To find out how many people visited a site, from what countries, and what pages of the 
site they viewed: 

1 Click the Report icon in the Domain group. 

2 View the statistics for the web pages or files downloaded from or 
uploaded to specific areas of your site: 

Á To view the statistics for web pages transferred from your site over hypertext 
transfer protocol (HTTP), click Web Stats. 

Á To view the statistics for web pages transferred from your site over secure 
hypertext transfer protocol (HTTPS), click Web Stats SSL. 

Á To view statistics for files transferred over file transfer protocol (FTP), click FTP 
Stats. 

Á To view statistics for files transferred via anonymous FTP, click Anon.FTP Stats. 

Á To view the bandwidth usage by months, click the Traffic History icon. 

Á To view the bandwidth usage by FTP, Web and mail services in this domain, 
click the Traffic icon. 

Note: If you use Webalizer statistical package on your account, you can customize 
the graphical reports shown by Webalizer. For instructions, refer to the Adjusting 
Preferences for Web Statistics Presentation by Webalizer (see page 92) section. 

Alternately, you can view the Web statistics for a site by visiting the following URL: 
https://your-domain.com/plesk-stat/webstat. When prompted for username and 
password, specify the credentials for your FTP account. 
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Common operations on reports: 

Á To get more details, select the Full Report option from the Report drop-down menu. 

Á To adjust the amount of information presented in a report, click  Customize, and 
then modify an existing report template (to do this, click a report template name) or 
create a new report template (to do this, click the Add New Layout icon). Next, specify 
how much information you want in each section of the report: select None if you do 
not want any information, select Summary if you want a concise overview, or select 
Full if you need a detailed report. Select the Use as default report check box and click 
OK. To delete a custom report layout, select the checkbox corresponding to the 

report layout name and click  Remove Selected.  

Á To print the report, click the  Print icon. A report will open in a separate browser 
window. Select the File > Print option from the browser's menu to print the report. 

Á To send the report by e-mail, type the recipient's e-mail address into the input box 

located to the right of the Report group and click the  Send by E-mail icon. If you 
are the recipient, then you do not need to specify an e-mail address: the system 
assumes by default that you are the report recipient and specifies your e-mail 
address registered with your control panel account. 

Á To have the reports automatically generated and delivered by e-mail on a daily, 
weekly, or monthly basis, click the Report Delivery icon and follow the instructions 
supplied in the Automating Report Generation and Delivery by E-mail section. 

In this chapter: 

Adjusting Preferences for Web Statistics Presentation by Webalizer .................92 
Automating Report Generation and Delivery by E-mail ......................................93 
Viewing Log Files and Configuring Recycling of Log Files .................................94 

 
 

Adjusting Preferences for Web Statistics 
Presentation by Webalizer 

By default, statistical utility counts and reports the requests for web pages and other 
files made from your own site ï by your web pages. So, when a userôs browser 
requests from your site a single web page that contains references to other files, such 
as scripts, cascading style sheets, media files, and the like, the statistical utility reports 
these references to files as if they were visits to your web page. Thus, with the default 
settings your usage statistics is inaccurate. 

You may want to: 

Á Hide these internal references, and references from other sites. 

Á Group references from a number of sites, so as to show them as if they originated 
from a single location. 

Á Hide direct requests. Direct requests are sent to your web server when users 
access your site by typing the URL in their browsers. 
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Automating Report Generation and 
Delivery by E-mail 

ü To receive detailed reports on your domain on a regular basis: 

1 Go to Report > Layouts > report type > Report Delivery > New Delivery Schedule. 

2 To receive the report to your e-mail address registered with the 
system, select the the domain administrator value from the Deliver to drop-
down menu. To receive the report to another e-mail address, select 
the e-mail address I specify option and type the e-mail address.  

3 Select the delivery interval from the Delivery frequency drop-down menu. 
You can have the report delivered each day, each week, or each 
month. 

4 Click OK. 

ü To change the delivery schedule for a detailed domain/web site report: 

1 Go to Report > Layouts > report type > Report Delivery. 

2 Under the Frequency column, click a hyperlink corresponding to the 
delivery schedule you would like to change. 

3 Adjust the settings as required and click OK. 

ü To stop receiving the account status reports: 

1 Go to Report > Layouts > report type > Report Delivery. 

2 Select a check box corresponding to the delivery schedule and click 

 Remove Selected. Confirm removal and click OK. 
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Viewing Log Files and Configuring 
Recycling of Log Files 

All connections to the Web server and requests for files that were not found on the 
server are registered in log files. These log files are analyzed by the statistical utilities 
running on the server, which then present graphical reports on demand. You may want 
to download these log files to your computer for processing by third-party statistical 
utilities, or view their contents for web server debugging purposes. 

To prevent these log files from growing too large, you should enable automatic cleanup 
and recycling of log files. 

ü To enable automatic cleanup and recycling of log files: 

1 Go to Log Manager > Log Rotation and click Switch On in the Tools group. 

2 Specify when to recycle log files and how many instances of each log 
file to store on the server. Also specify whether they should be 
compressed and sent to an e-mail address after processing. 

3 Click OK. 

To view the contents of a log file or download it to your computer, click Log Manager in 
the Hosting group. A list of log files will show. 

Á To specify the number of lines from the end of the log file that you would like to 
view, type a number into the input box under the Preferences group. 

Á To view the contents of a log file, click its file name.  

Á To download a file to your computer, click the  icon corresponding to the file you 
need.  

Á To remove a processed log file from the server, select a corresponding check box, 

click  Remove Selected, confirm removal and click OK. 

 

 



 

  
 

With the current version of backup and restore utilities installed with your control panel, 
you can: 

Á Back up your domain (Web site). The backup archive will include all data related to 
your account (except for resource allotments and permissions to perform operations 
within the control panel), domain (web site) and mail services, including the 
contents of mailboxes, Horde Turba address book contact lists, anti-spam and anti-
virus settings. 

Á Schedule backups.  

Á Restore your data from backup archives. 

You can access your backup repository via your Home page (Home > Backup). 

In this chapter: 

Configuring Control Panel for Using FTP Repository ......................................... 95 
Backing Up Your Domain .................................................................................. 96 
Scheduling Backups .......................................................................................... 96 
Restoring Data From Backup Archives .............................................................. 97 
Maintaining Your Backup Files Repository ........................................................ 97 
 
 

Configuring Control Panel for Using FTP 
Repository 

If you are going to use an FTP server for storing backup files, you should set up the 
control panel appropriately: 

1 Go to Home > Back Up > FTP Repository  > FTP Account Properties. 

2 Specify the following properties: 

Á FTP server's IP address or host name. 

Á Directory on the server, where you want to store backup files. 

Á User name and password for access to the FTP account. 

3 Click OK. 
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Backing Up Your Domain 

ü To back up your domain (web site): 

1 Click the Back Up icon in the Domain group. 

2 If you want to back up and store the backup file on an FTP server, 
click the FTP repository tab, then click FTP Account Properties to specify the 
destination FTP server (as described in the Configuring Control Panel 
for Using FTP Repository (see page 95) section), if you have not done 
so yet. 

3 Click the Backup Now icon in the Tools group. 

4 Specify the backup file name and give a description to the backup file.  

5 To create a multivolume backup, select the respective check box and 
specify volume size in megabytes. 

6 Select the repository where you would like to store the backup file.  

7 Click Back Up Now. 

8 The backup will start and the progress will be shown.  

Á To update the information on the screen, click Refresh. 

Á To cancel the backup, click Cancel and confirm the cancellation by clicking OK. 

9 Upon completion of the backup process you will be shown a window 
displaying the backup results, including errors, if they were 
encountered. Click OK. 

The backup file will be saved to the repository you selected, and will be accessible 
either from the FTP server, or from the location Home > Backup. 

Scheduling Backups 

ü To schedule backup of your domain (web site): 

1 Click the Backup icon in the Tools group. 

2 Click the Schedule Backup icon in the Tools group. 

3 Specify when and how often to perform backup. 

4 To enable recycling of backup files, clear the Unlimited check box and 

type the maximum allowed number of files in the repository.  

When this limit is reached, the oldest backup files are removed. 

5 Specify the combination of symbols that backup file names should 
begin with.  

This will help you distinguish between backup files. 

6 Select the repository where you would like to store the backup file.  
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7 To create a multivolume backup, select the respective check box and 
specify volume size in megabytes. 

8 Click the Switch On icon in the Tools group. 

9 Click OK. 

 
 

Restoring Data From Backup Archives 

ü To restore your domain (Web site): 

1 Click the Backup icon in the Tools group. 

2 If you wish to restore data from a file stored on an FTP server , click 
the FTP Repository tab. 

3 Click the backup file name you need. 

4 Click Restore Now. 

Á To update the information on the screen, click Refresh. 

Á To cancel the restoring process, click Cancel and confirm the cancellation by 
clicking OK. 

5 Upon completion of the restoring process you will be shown a window 
displaying the restoration results, including errors, if they were 
encountered.  

6 Click OK. 

 
 

Maintaining Your Backup Files Repository 

This section provides instructions on: 

Á Uploading backup files stored on another computer. 

Á Downloading backup files to another computer. 

Á Removing redundant backup files from the backup repository. 

 

 

In this section: 

Uploading Backup Files to Server ..................................................................... 98 
Downloading Backup Files from Server ............................................................. 98 
Removing Backup Files from Server ................................................................. 98 
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Uploading Backup Files to Server 

ü To upload a backup file to the control panel's backup repository: 

1 On your Home page, click the Backup icon in the Tools group. 

2 Click Upload Files to Local Repository. 

3 Click Browse and select the required backup file. 

4 Click OK. 

The backup file will be uploaded to the backup repository. 
 

Downloading Backup Files from Server 

ü To download a backup file from the control panel's backup repository: 

1 On your Home page, click the Backup icon in the Tools group. 

2 Click the  icon corresponding to the backup file you wish to 
download. 

3 Select the location where you wish to save the backup file and click 
Save. 

The backup file will be downloaded from the backup repository. 
 

Removing Backup Files from Server 

ü To remove a backup file from the control panel's backup repository: 

1 On your Home page, click the Backup icon in the Tools group. 

2 Select a check box corresponding to the backup file you wish to 
remove. 

3 Click  Remove Selected.  

4 Confirm removal and click OK. 
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If you need to run scripts on your site at specific time, use the task scheduler on your 
provider's server to make the system automatically run the scripts for you. 

In this section: 

Scheduling a Task ............................................................................................. 100 
Suspending and Resuming Execution of Tasks ................................................. 101 
Unscheduling a Task ......................................................................................... 101 
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Scheduling a Task 

ü To schedule a task: 

1 On your Home page, click the Scheduled Tasks icon. 

2 Select the system user account on whose behalf the task will be 
executed. 

3 Click Add New Task. 

4 Specify when to run your command. 

Á Minute - enter the value from 0 to 59 

Á Hour - enter the value from 0 to 23 

Á Day of the Month - enter the value from 1 to 31 

Á Month - enter the value from 1 to 12, or select the month from a drop-down box 

Á Day of the Week - enter the value from 0 to 6 (0 for Sunday), or select the day of 
the week from a drop-down box 

You can schedule the time using the UNIX crontab entry format. In this format, you 
can 

Á enter several values separated by commas. Two numbers separated by a 
hyphen mean an inclusive range. For example, to run a task on the 4th, 5th, 6th, 
and 20th of a month, type 4-6,20. 

Á insert an asterisk to specify all values allowed for this field. For example, to run 
a task daily, type * in the Day of the Month text box. 

To schedule the task to run every Nth period, enter the combination */N, where N is 
the legal value for this field (minute, hour, day, month). For example, */15 in the 
Minute field schedules the task to start every 15 minutes.  

You can type the contracted names of months and days of the week, which are the 
first three letters: Aug, Jul, Mon, Sat, etc. However, the contracted names cannot 
be separated with commas or used together with numbers. 

5 Specify which command to run. Type it into the Command input box. 

6 Click OK. 
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Suspending and Resuming Execution of 
Tasks 

ü To temporarily suspend execution of scheduled task: 

1 On your Home page, click Scheduled Tasks in the Hosting group. 

2 Select the system user account on whose behalf the task is executed. 

3 Locate the task that you want to suspend and click the command 
name. 

4 Clear the Switched on check box and click OK. 

 

ü To resume execution of scheduled task: 

1 On your Home page, click Scheduled Tasks in the Hosting group. 

2 Select the system user account on whose behalf the task is executed.  

3 Locate the task whose execution you want to resume and click the 
command name. 

4 Select the Switched on check box and click OK. 
 

Unscheduling a Task 

ü To unschedule a task: 

1 On your Home page, click Scheduled Tasks in the Hosting group.  

2 Select the system user account on whose behalf the task is executed.  

3 Select a check box to the left of the task that you want to unschedule 

and click  Remove Selected. Confirm removal and click OK. 
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In this section: 
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Monitoring Connections to FTP Service ............................................................ 103 
 
 

Monitoring Connections to Control Panel 

ü To find out who of your customers is logged in to the control panel at the moment: 

1 Click Sessions in the navigation pane. All sessions including yours will 
be presented and the following details will be displayed:  

Á Type. A type of control panel user who established the session:  

 for domain or Web site owner. 

 for mailbox owner. 

Á Login. The login name the user is logged in as. 

Á IP address. The IP address from which the control panel is accessed. 

Á Logon time. The date and time when the user logged in to the control panel. 

Á Idle time. The time that user was not doing anything in the control panel while 
being logged in. 

2 To refresh the list of user sessions, click Refresh. 

3 To end a user session, select the respective check box and click  
Remove Selected, then confirm removal and click OK. 
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Monitoring Connections to FTP Service 

ü To find out who is connected to your server via FTP, in what directories they currently 
are and what files they are uploading to or downloading from the server: 

1 Go to Sessions and click the FTP Sessions tab. All sessions including 
yours will be presented and the following details will be displayed:  

Á Type. The type of user who established the session:  

 for users not registered with the control panel. 

 for anonymous FTP users. 

 for domain or web site administrators. 

 for subdomain administrators. 

 for web users (owners of personal web pages without individual domain 
names). 

Á Status. The current status of FTP connection. 

Á FTP user login. The login name used for access to FTP account. 

Á Domain name. The domain the FTP user is currently connected to. 

Á Current location. The directory the FTP user is currently at. 

Á File name. The file name being operated on. 

Á Speed. Transfer speed in kilobytes. 

Á Progress, %. The file transfer operation progress in percentage. 

Á IP address. The IP address from which the FTP account is accessed. 

Á Logon time. The time lapsed since the moment user logged in. 

Á Idle time. The time that user was not doing anything while being connected to the 
server through FTP. 

2 To refresh the list of FTP sessions, click Refresh. 

3 To end a session, select the respective check box and click  Remove 
Selected. 

 



 

  
 

If your service provider offers a Help Desk solution integrated with the control panel, 
then you can use it to report your problems to your providerôs technical support staff. 

In this chapter: 

Submitting a Problem Report to Your Service Provider ..................................... 105 
Commenting and Closing Your Trouble Ticket .................................................. 105 
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Submitting a Problem Report to Your 
Service Provider 

ü To submit a new problem report to your service provider: 

1 Go to Help Desk and click Add New Ticket. 

2 Type the ticket subject, select the category the issue is related to, and 
type in the problem description. 

3 Click OK.  

The ticket is now submitted to the system and sent to your provider. You will be notified 
by e-mail when the issue is resolved. 

Commenting and Closing Your Trouble 
Ticket 

ü To post a new comment or to close a ticket: 

1 Click the Help Desk shortcut in the navigation pane. 

2 Locate the ticket you need and click its subject or identification 
number. 

3 To close, reopen or post a comment to the ticket, select the operation 
you would like to perform from the Ticket Event drop-down box, and type 
a new comment into the New Comment input field if required. 

4 Click OK to submit. 

 

 


